NOTICE

The information contained in this document is believed to be accurate in all respects but is not warranted by Mitel Networks Corporation (MITEL®). The information is subject to change without notice and should not be construed in any way as a commitment by Mitel or any of its affiliates or subsidiaries. Mitel and its affiliates and subsidiaries assume no responsibility for any errors or omissions in this document. Revisions of this document or new editions of it may be issued to incorporate such changes.

No part of this document can be reproduced or transmitted in any form or by any means - electronic or mechanical - for any purpose without written permission from Mitel Networks Corporation.

COPYRIGHT

6510 Unified Messaging Client Application Installation and User Guide

Release 1.5

July 2005

®, ™ Trademark of MITEL Networks Corporation

©Copyright 2005, MITEL Networks Corporation

All rights reserved

TRADEMARKS

MITEL and Mitel Networks are trademarks of Mitel Networks Corporation.

Other brands and their products are trademarks or registered trademarks of their respective holders and should be noted as such.
About This Guide

In This Chapter...

Document Overview on page 2
Intended Audience on page 3
Before You Begin on page 3
Conventions on page 3
Contacting Mitel Networks™ on page 4
About This Guide

Document Overview

This guide has been developed to describe the installation and functionality of the Client Applications that are available with the 6510 UM server.

**Note:** This document describes the installation procedures for new installs of the Client Applications. The procedures may vary slightly during upgrade installations.

The availability of the Client Applications and their features and functionality is determined by a user's classification on the 6510 UM system.

As you read through the guide, you will see notations indicating which features are available to a certain class of user.

As it pertains to the use of the Client Applications, the user classes are broken down as follows:

<table>
<thead>
<tr>
<th>Standard</th>
<th>Advanced</th>
<th>Unified</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Definition</strong></td>
<td>Integrated Messaging users who use their e-mail client to view voice and fax messages. For Outlook and Lotus Notes users, Forms may be installed for additional message record and playback options.</td>
<td>Integrated Messaging users with Client Applications licenses.</td>
</tr>
</tbody>
</table>

Your user class has been determined upon initial deployment of the system. If there is any feature or functionality described in this document to which you require access, please contact your System Administrator. Additional licensing may be required for the applications.
About This Guide

Intended Audience
This document is intended for end users installing and using the client applications for their personal use.

Before You Begin
Make sure you have the appropriate software or ask your system administrator for access to the software on your company’s network.

Conventions
This guide uses the following conventions to convey specific information:

Note: Contains additional information about the task you are performing.

Hint: Contains an alternative method of performing the task or offers a solution if you run into a problem.

Caution: Information that alerts you to potential loss of data, or damage to an application, system, or device.

Warning: Information that alerts you to potential personal injury.
Contacting Mitel Networks™

Contact us by mail at:
Mitel Networks Corporation
350 Legget Drive
Ottawa, ON K2K 2W7

Contact us by phone:
Tel: 613-592-2122
Fax: 613-592-4784

Contact us on the Web:
www.mitel.com
CHAPTER 1   Installing the Web Client

In This Chapter...

Overview on page 6
Configuring Your Browser on page 6
Downloading the Java Plug-In on page 14
Installing the Java Plug-In on page 15
Downloading Permissions on page 16
Installing Permissions on page 17
Overview

The Web Client is a web-based interface that provides a user with access to their 6510 UM account and features over the Internet.

**Note:** This application is only available to Advanced or Unified users. For an explanation of the different user types, refer to the About This Guide section in this document.

There are four preliminary steps that need to be performed prior to configuring the Web Client. These are as follows:

1. Configure the 6510 UM Server to install Web Client services.
   **Note:** This is a system administration task which will have been completed by your 6510 UM System Administrator.

2. Configure your Internet browser to support the 6510 UM Portal for the Web Client.

3. Install the Java Plug-In to listen to voice messages over the web.

4. Install the Permissions for Java to allow you to record voice messages and greetings over the web.

Configuring Your Browser

Web Client requires a Microsoft Internet Explorer version 6.0 or greater and Netscape 6.2 or greater to run properly.

If your browser does not meet these requirements, then you will need to update it as described below in order to run the Web Client.

As well, you will need to configure your browser to ensure that new pages are downloaded each time you view a web page.
To check the Microsoft Internet Explorer version:

1. Open Microsoft Internet Explorer.
2. Click Help > About Internet Explorer.

The About Internet Explorer window appears.

3. If the version number is less than 6.0, click Update Information to go to the Microsoft website and update your Internet Explorer browser version.
Installing the Web Client

To configure Microsoft Internet Explorer:

1. Open Microsoft Internet Explorer.
2. Click **Tools>Internet Options**.

   The Internet Options dialog appears.

3. Under **Temporary Internet Files**, click **Settings**.
Installing the Web Client

The Settings dialog appears.

4. Under **Check for newer versions of stored pages**, select **Every visit to the page**. This will ensure that you are always viewing new web pages instead of cached ones.

5. Click **OK**. You are now back at the Internet Options window.

6. Click the Advanced tab.
Installing the Web Client

The Advanced settings window appears:

7. Scroll down the list to the **Java (Sun)** field and deselect the **Use Java 2 v.1.3.1_03 for <applet> (requires restart)** setting. This will ensure that you do not have to login twice to the Web Client application.
Installing the Web Client

Note: The Java version may vary on each computer.

8. Click **Apply** and then **OK**.

9. Shut down Internet Explorer and then restart it.
Installing the Web Client

- To check the Netscape Navigator version:

1. Open Netscape Navigator.
2. Click **Help > About Netscape**.

The About Netscape window appears.

3. If the version number is less than 6.2, you will need to download the latest browser version from the following website:

   http://channels.netscape.com/ns/browsers/download.jsp
To configure Netscape:

1. Open Netscape.

2. Click Edit>Preferences. The Preferences dialog appears.

3. Under the Advanced category, click Cache. The Cache dialog appears in the right window.

4. Under Compare the page in the cache to the page on the network, select Every time I view the page. This will ensure that you are always viewing new web pages instead of cached ones.
Installing the Web Client

Downloading the Java Plug-In

The Java Plug-In allows a user to listen to voice messages over the web. Before you can install the Java Plug-In, you must first download it from Web Client.

- To download the Java Plug-In:
  1. Close all applications that are running.
  2. Open your browser.
  3. Enter the IP address of the 6510 UM server in the Address line, followed by /um/webclient and click Go.

  Note: See your System Administrator for the exact IP address of your 6510 UM server.

  The Web Client login dialog screen appears.

  4. From the Getting Started drop-down list, select 1|Java Plugin, then click Go. The File Download dialog appears.
Installing the Web Client

5. Click **Save this program to disk**. The Save As dialog appears.
6. Click **OK**.
7. Select either a directory in which to save the file or accept the default directory and click **Save**.
8. When the download has finished, click **Close**.

Installing the Java Plug-In

After downloading the Java Plug-In, you can install it onto your PC.

◆ **To install the Java Plug-In:**

1. Navigate to the directory containing the Java Plug-In installation file.
2. Double-click on the `j2re-1_3_1_03-win-i.exe` file. The Software License Agreement dialog appears.
3. Click **Yes**. The Choose Destination Location dialog appears.
4. Click **Next**. The Select Browsers dialog appears.
5. Select the checkbox beside the browser that you are using and click **Next**.

The Java 2 runtime environment dialog box appears and begins the installation.

When the installation is complete, an Installation Completed dialog appears and the active window returns to the directory containing the Java installation file.
Installing the Web Client

Downloading Permissions

The permissions allow you to record greetings and voice messages over the web.

◆ **To download permissions:**

1. Exit all applications that are running.
2. Open your browser.
3. Enter the IP address of the 6510 UM server in the Address line, followed by `/um/webclient` and click **Go**.

The Web Client login dialog box appears.

4. From the Getting Started drop-down list, select **2 | Grant Permission** and click **Go**. The File Download dialog appears.
5. Click **Save this program to disk**. The Save As dialog appears.
6. Click **OK**.
7. Select either a directory in which to save the file or accept the default directory and click **Save**.
8. When the download has finished, click **Close**.
Installing the Web Client

Installing Permissions

Once you have downloaded the permissions, you can install them onto your PC.

- **To install permissions:**
  
  1. Navigate to the directory containing the Permission installation file.
  
  2. Double-click **GrantPermission**. The Installing dialog box appears and begins installing the permissions.

     The Set Client-Side Permission dialog appears.

     ![Set Client-Side Permissions dialog]

     **Please enter the Web-Site address of your Web-Client server:**

     [http://]

     

     3. Enter the IP address of the 6510 UM Server and click **OK**. A dialog appears, confirming that the permission is granted.

     **Note:** See your System Administrator for the exact IP address of your 6510 UM server.

     4. Click **OK**. You can now use the record and playback function in the web client.
Installing the Web Client

Getting Started

After downloading and installing both the Java plug-in and the Grant Permissions program, you will be able to use the full functionality of the web client application. Before you can do this, you must restart the browser in order for the permissions to take effect. From the main login screen, enter your numerical user ID and password to access your account.

Note: You only need to restart the browser if you have logged into your mailbox.
CHAPTER 2  Installing the Client Manager

In This Chapter...

Overview on page 20
Downloading the UM Client Manager on page 22
Installing the UM Client Manager on page 22
Configuring Main Settings on page 32
Overview

The 6510 Client Manager allows a user to access the following features from the desktop:

- LanTalk Instant Messaging
- Caller ID Screen Pops that are directed to you via the 6510 Auto Attendant
- Change personal status (in/out of office)
- Change passwords for user login
- Call control on incoming calls that are directed to you via the 6510 Auto Attendant
- Dialing from the desktop

The Client Manager also installs both voice and fax forms that are used in conjunction with Microsoft Outlook or Lotus Notes so that users can view their voice and fax messages from their Inbox.

Note 1: This application is available to all users. However, the functionality of this application may be limited for some user types. For an explanation of the different user types, refer to the About This Guide section in this document.

Note 2: The installation of the Client Manager requires you to have administrator privileges for the PC on which you are installing the application.
# Installing the Client Manager

## Minimum Requirements

<table>
<thead>
<tr>
<th>Hardware/Software</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>600mhz 128mb RAM</td>
</tr>
<tr>
<td>OS</td>
<td>Windows 98</td>
</tr>
<tr>
<td>Browser</td>
<td>Netscape Navigator 6.2</td>
</tr>
<tr>
<td></td>
<td>Internet Explorer 6.0</td>
</tr>
</tbody>
</table>

## Recommended Configuration

<table>
<thead>
<tr>
<th>Hardware/Software</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Intel Pentium 3 600mhz 256mb RAM</td>
</tr>
<tr>
<td>OS</td>
<td>Windows NT w/SP6</td>
</tr>
<tr>
<td></td>
<td>Windows 2000 w/SP2</td>
</tr>
<tr>
<td></td>
<td>Windows XP w/SP1</td>
</tr>
<tr>
<td>Browser</td>
<td>Netscape Navigator 6.2+</td>
</tr>
<tr>
<td></td>
<td>Internet Explorer 6.0+</td>
</tr>
</tbody>
</table>
Installing the Client Manager

Downloading the UM Client Manager

Before you can install 6510 Client Manager, you must download the software from the Web Client login page.

◆ To download the UM Client Manager:

1. Exit all applications that are running.
2. Open your browser.
3. Enter the IP address of the 6510 UM server in the Address line, followed by /um/webclient/ and click Go. The Web Client login page appears.
4. From the Getting Started drop-down list, select 3UMClient Manager and click Go. The File Download dialog appears.
5. Click Save this program to disk. The Save As dialog appears.
6. Click OK.
7. Select either a directory in which to save the file or accept the default directory and click Save.
8. When the download has finished, click Close.

Installing the UM Client Manager

Once you have downloaded the 6510 UM Client Manager software (.exe), you can install it onto your PC.

Note 1: Make sure you have administrator privileges for your PC before you proceed to install the Client Manager.

Note 2: The system will prompt you to close your e-mail client if it is in use before installing the Client Manager.
Installing the Client Manager

To install the 6510 UM Client Manager:

1. Navigate to the directory containing the 6510 UM Client Manager installation .exe file. The following dialog appears:

   ![About Client Applications dialog]

   If Outlook or Lotus is running on your computer, please close it and click OK to continue. Click Cancel to quit Setup.

2. The Welcome screen appears:
3. Click **Next**. The License Agreement screen appears:
4. Select the **I accept the license agreement** radio button, then click **Next**. The Choose Destination Location screen appears:
5. Click **Next**. The Select Components screen appears:

6. Select the following:
   - the **Outlook Forms** checkbox if you are using Outlook.
   - the **Lotus Forms** checkbox if you are using Lotus Notes.
Installing the Client Manager

7. Click **Next**. The Login Information screen appears:

8. Enter the following information:
   - **Company Number**: Enter your company number.
     
     **NOTE**: The default value for this field is 1. Ask your System Administrator if you do not know your company number (if one does exist).

   - **Mailbox Number**: Enter your mailbox number.

   - **Password**: Enter the password that you use to log in to your voicemail via the telephone.
Installing the Client Manager

9. Click **Next**. The Voice and Web Servers Names screen appears:

10. Enter the following information:
    - In the **UMST Server** field, enter the IP address of the Voice Server.
    - In the **Web Server** field, enter the IP address of the Web Server.
11. Click **Next**. The installation begins:

12. If you selected the **Outlook Forms** check box back on the Select Components screen, the following dialog appears:
13. Click OK. As the installation ends, the following confirmation dialog appears:

14. Click OK. The Installation Complete screen appears:
15. Click **Finish**. The GroupWare Forms Configuration screen appears:

```
If you'd like to configure GroupWare Forms Properties click "Yes" button otherwise click "No".
```

16. Clicking **No** concludes the installation process by taking you to your desktop. You can configure your call handling properties at a later time. Clicking **Yes** allows you to continue the process with the configuration of your main settings. For specific configuration instructions, follow the steps in the procedure that follows (Configuring Main Settings).
Configuring Main Settings

This function allows you to configure the personal settings required so that you can log in successfully.

Caution: This information must be correct in order for the UM Call Manager and the Outlook Forms or Lotus Forms to work properly.

◆ To configure main settings:

1. After clicking Yes in the GroupWare Forms Configuration tab, the 6510 UM Client Manager configuration window appears.

Note: The main mailbox, address and port information is automatically populated by the system if you entered them correctly during the installation process. If certain fields are not populated, refer to the following steps 2-5 for details. Proceed to step 6 if the main fields are already populated.
2. In the **Company field**, enter the company number name that your account is associated with on the 6510 UM server.

**Note:** Contact your System Administrator if you do not know your company number. The default value is 1.

3. In the **Mailbox** field, enter your mailbox number for voice mail.

4. In the **UMST Server IP Address** field, enter the UMST IP address so that the system can authenticate you using TCP/IP.

**Note:** Contact your System Administrator if you do not know your UMST Server IP Address.

5. In the **UMST Server Port**, enter the UMST server port number.

**Note:** Contact your System Administrator if you do not know your UMST Server Port number. The default value is 13777.

6. In the **Keep connection alive** field, place a checkmark in the box if you would like the UM Client Manager to maintain a connection with the UMST.

**Note:** When this option is selected, the UM Client Manager will attempt to reconnect to the UMST if the connection is lost between the two components.

7. In the **UM Client Language** drop-down list, select the language that is to be used.

8. In the **Fax Viewer** field, enter the file name and location of the application you currently use to view .tiff files. If you leave this field blank, 6510 UM Client Manager will use the default viewer associated with your operating system.
9. Click **Set Password** to set your user password. The Set Password dialog appears.

![Set Password Dialog](image)

10. In the **Set Password** field, enter your new password, and then click **OK**.

11. The 6510 UM Client Manager Main Options dialog reappears. Click **OK** to finish the configuration.

The full installation and initial setup of the 6510 UM Client Manager is now complete.

To launch the UM Client Manager from your desktop, click on the following path:

```
Start>Programs>UM Client Manager>UM Client Manager
```

Refer to Chapter 3 of this guide for details on configuring the settings for the 6510 UM Client Manager. The available settings will be dependent on the features enabled on each user's license.
In This Chapter . . .

Overview on page 36
Using the UM Client Manager on page 37
Configuring the UM Client Manager on page 42
Using the UM Call Manager on page 53
Changing Your Status on page 59
Using LanTalk on page 61
Using the Outlook Toolbar on page 70
Using UM Client Manager Forms in Lotus Notes on page 82
Processing Attachments in Lotus Notes on page 88
Overview

The 6510 Unified Messaging system is an IP-based desktop application that allows you to access several unique communication features, such as call control, instant messaging, and unified messaging.

You can log into the UM server from any PC connected to the Internet, provided you have the correct network settings. After you enter the IP address of the 6510 UM server, you are logged in and can access the available communication functionality.
Using the UM Client Manager

Signing On

Signing on allows you to begin the UM Client Manager program.

♦ To log onto the UM server:

1. Click **Start** > **Programs** > **UM Client Manager** > **UM Client Manager**.

   **Hint:** You can also double-click on the UM Client Manager icon on the desktop.

   The UM Client Manager will automatically load into your system tray after authentication, and will sit awaiting call activity.

   The status of your UM Client Manager session is represented by a number of icons:

<table>
<thead>
<tr>
<th>Icons</th>
<th>Session Status</th>
<th>Available to</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Logged in" /></td>
<td>Logged in</td>
<td>All users</td>
</tr>
<tr>
<td><img src="image" alt="Logged in with new message waiting" /> (flashing)</td>
<td>Logged in with new message waiting</td>
<td>Advanced and Unified users</td>
</tr>
<tr>
<td><img src="image" alt="Logged out" /></td>
<td>Logged out</td>
<td>All users</td>
</tr>
<tr>
<td><img src="image" alt="Disconnected" /></td>
<td>Disconnected (system detects Client Manager settings, but no connection is established)</td>
<td>All users</td>
</tr>
</tbody>
</table>
The status of your availability is represented by any of the following icons:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Status</th>
<th>Advanced and Unified users</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Busy" /></td>
<td>Busy</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="In Meeting" /></td>
<td>In Meeting</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Do Not Disturb" /></td>
<td>Do Not Disturb</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Lunch Time" /></td>
<td>Lunch Time</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Gone Home" /></td>
<td>Gone Home</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Away On Business" /></td>
<td>Away On Business</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="On Vacation" /></td>
<td>On Vacation</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="No Answer" /></td>
<td>No Answer</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="In Office and Logged In" /></td>
<td>In Office and Logged In (Shown In LanTalk Directory)</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="In Office and Not Logged In" /></td>
<td>In Office and Not Logged In (Shown In LanTalk Directory)</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Standard User" /></td>
<td>Standard User, no Desktop access (Shown In LanTalk Directory)</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** When UM Client Manager is enabled by default, a notification window will pop up above the UM Client Manager icon whenever new messages are received. This can be turned off in the Options/Notification Settings of the Client Manager. The Notification window will display the
number of new voice, text, and fax messages if the Show Message Count option is enabled in the Administration console. Refer to Feature Groups>Mailbox Options in the Server Configuration Guide.

Logging Off

Logging off closes the UM Client Manager and ends your session.

◆ To log off from the UM Client Manager:

1. Right-click on the UM Client Manager icon and click **Exit**. The following message appears:

![Image of UM Client Manager exit confirmation dialog]

2. Click **Yes**.

UM Client Manager Connectivity

At times when the UM Client Manager is unable to connect to the IMAP store or to your mailbox, dialogs will appear that prompt you to regain connectivity.

◆ To unlock mailbox:

1. When the system fails to establish a connection to the IMAP store, the Unlock Mailbox dialog appears.

![Image of Unlock Mailbox dialog]

2. Click **OK**. The system attempts to re-establish the connection. If connection is established, the Unlock Mailbox dialog will disappear. If the connection is not established, the Unlock Mailbox dialog will re-appear. Click **OK** again until the connection is established.

**To reconfigure IMAP settings:**

1. When the system fails to establish a connection with a specific mailbox in the IMAP store, the IMAP Settings dialog appears.

2. In the **User Name** field, enter your IMAP user name.

   **Note:** The IMAP user name is the e-mail account user name that is set on the Exchange server (in the Active Directory). See your System Administrator if you do not know your IMAP user name.

3. In the **Old Password** field, enter the old password associated to your IMAP user name.

4. In the **Password** field, enter a new password for your IMAP user name.

5. In the **Confirm Password** field, re-enter the new password for confirmation.
6. Click **OK**. The system re-attempts to connect to the specific mailbox in the IMAP Store.

- **To reset password when prompted:**

1. When your account attempts to log into the UM Client Manager and the password is not valid, the Set Password dialog appears.

2. In the Set Password field, enter the correct password for your account.

3. Click **OK**. If the correct password is entered, the system logs you into the UM Client Manager.

**Note:** If your connection to the 6510 server is lost at any time (due to network issues), the Login dialog will appear. Click OK to close the dialog and re-establish a connection with the 6510 server. The Login dialog will continue to appear intermittently if connection to the server is not re-established.
Configuring the UM Client Manager

Before you can use UM Client Manager, you must configure the application. While the Main Settings are normally set when the application is installed on your PC, you have the option of changing the settings.

**Note:** This task is only applicable to Advanced or Unified users. For an explanation of the different user types, refer to the *About This Guide* section in this document.

There are four main settings to configure for the application.

- Main Settings
- Call Handling
- LanTalk (Instant messaging) Settings
- Notification Settings
Configuring Main Settings

This function allows you to configure the personal settings required so that you can log in successfully.

**Caution:** This information must be correct in order for the UM Call Manager and the Outlook Forms or Lotus Forms to work properly.

◆ To configure main settings:

**Note:** Skip this procedure if you have already configured the main settings during the installation of the 6510 UM Client Manager.

1. From your desktop, click on **Start>Programs>UM Client Manager>Configuration**.

The 6510 UM Client Manager configuration window appears.
Using the UM Client Manager and Desktop Applications

Note: The main mailbox, address and port information is automatically populated by the system if you entered them correctly during the installation process. If certain fields are not populated, refer to the following steps 2-5 for details. Proceed to step 6 if the main fields are already populated.

2. In the **Company field**, enter the company number name that your account is associated with on the 6510 UM server.

Note: **Contact your System Administrator if you do not know your company number. The default value is 1.**

3. In the **Mailbox** field, enter your mailbox number for voice mail.

4. In the **UMST Server IP Address** field, enter the UMST IP address so that the system can authenticate you using TCP/IP.

Note: **Contact your System Administrator if you do not know your UMST Server IP Address.**

5. In the **UMST Server Port** field, enter the UMST server port number.

Note: **Contact your System Administrator if you do not know your UMST Server Port number. The default value is 13777.**

6. In the **Keep connection alive** field, place a checkmark in the box if you want to maintain a connection with the UMST.

Note: **When this option is selected, the UM Client Manager will attempt to reconnect to the UMST if the connection is lost between the two components.**

7. In the **UM Client Language** drop-down list, select the language that is to be used.

8. In the **Fax Viewer** field, enter the file name and location of the application you currently use to view .tiff files. If you leave this field blank, 6510 UM Client Manager will use the default viewer associated with your operating system.

9. Click **Set Password** to set your user password. The Set Password dialog appears.

10. In the **Set Password** field enter a new password, then click **OK**.

11. The 6510 UM Client Manager configuration window reappears. Click **OK** to finish the configuration.

*The initial setup of the 6510 UM Client Manager is now complete.*
Specifying Call Handling Settings

The Call Handling tab allows you to define the call handling settings, including PIM Integration, Default Action, New Call Popup, Public Contact Search, Auto Add Record and User Extension.

**Note:** This feature is only available to Advanced or Unified users. For an explanation of the different user types, refer to the About This Guide section in this document.

To specify call handling:

1. Log in to the 6510 UM Client Manager.
2. Select **Options**. The Options window appears.
3. Click the **Call Handling** tab. The Call Handling window appears.
4. Select **New Call Popup** to activate screen pops on incoming calls. When a new call arrives that is directed to you through the 6510 Auto Attendant, the Call Manager screen will appear.
Note: You will receive popups only when a call goes through your Auto Attendant or to your voice mail.

Note: In order for call popups to occur, this checkbox must be selected. In conjunction with this, the Transfer Options for each user’s mailbox must have Pop selected. Refer to the Web Client chapter in this guide for more details.

5. Select the **Use Phone Formatting** checkbox to enable phone formatting.

Note: Phone Formatting formats the telephone number with brackets around the area code and a dash between the numbers, as in the following example: (613) 555-1234.

6. From the **PIM Integration** drop-down list, select the Personal Information Manager (PIM) application you are using on this PC to integrate database look ups and screen pops on incoming calls.

Note: This feature will only function for calls that are directed through the 6510 Auto Attendant.
Using the UM Client Manager and Desktop Applications

The following table describes the related settings for each of the Personal Information Manager (PIM) applications in the drop-down list.

<table>
<thead>
<tr>
<th>Function</th>
<th>Related Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximizer</td>
<td>Select <strong>Auto Add Record on Not Found</strong> to add the call record if it is not found in the database. It takes the caller ID information including the name and number, and creates a new contact in Outlook or Act.</td>
</tr>
<tr>
<td>Goldmine</td>
<td>No related fields.</td>
</tr>
<tr>
<td>ACT!</td>
<td>Select <strong>Auto Add Record on Not Found</strong> to add the call record if it is not found in the database. It takes the caller ID information including the name and number, and creates a new contact in Outlook or Act.</td>
</tr>
</tbody>
</table>
| Outlook        | Select **Auto Add Record on Not Found** to add the call record if it is not found in the database. It takes the caller ID information including the name and number, and creates a new contact in Outlook or Act.  
    Select **Search Public Contacts** to search the public contact database on the office exchange server for matching contact number.  
    Select **Eliminate New Call Popup If Found** when you want to turn off call control and only popup the contact information on incoming calls. |
| Custom ActiveX | This allows for custom development of screen pops.  
    Contact your System Administrator for more information. |

7. From the **Default Action** drop-down list, select a default action. If you do not click on any actions on the incoming screen popup, the system will process the call based on the action you have assigned in this field.

**Note:** You can override these default actions by the actions that you may choose on an incoming screen pop.

<table>
<thead>
<tr>
<th>Action</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Take Call</td>
<td>Take the call automatically</td>
</tr>
</tbody>
</table>
8. In the **Use Ext.** field, select the extension type to be used to transfer a call, play back a voice message, and dial a number. You can select an **Internal**, **External**, or **Centrex** extension type.

**Note:** Centrex is a telephone company provided service that allows for PBX functionality through your telephones. In this application, selecting the Centrex extension type will initiate external dialing through the auto attendant, freeing your existing trunk lines for outbound.

9. In the **Country** drop-down list, select the country that is associated with the external extension.

10. In the **City/Area Code** field, enter the city area code for the external extension.

11. In the **Number** field, enter the extension number you are using, or, if you are using an external telephone number, enter the seven digit phone number.

**Note:** If you do not enter a phone extension, the system will use your extension.

12. Click **OK** to end and finish the configuration, or click another tab to continue the configuration.
Using the UM Client Manager and Desktop Applications

Configuring LanTalk

LanTalk is the instant messaging component of the 6510 UM system that allows users to chat with each other over an IP network. LanTalk messaging can be personalized so that each user can specify background and foreground colors, as well as font type and size.

Note 1: This feature is only available to Advanced or Unified users. For an explanation of the different user types, refer to the About This Guide section in this document.

Note 2: Check with your System Administrator whether you have access to this feature. You need to have several options enabled before you can access this feature.

◆ To configure LanTalk:

1. Log into the 6510 UM Client Manager.
2. Click the LanTalk tab. The LanTalk window appears.

![LanTalk Configuration Window]

- LanTalk Popup
- New LanTalk \ Window for every Session
3. Select the **LanTalk Popup** checkbox to turn on instant messaging.

4. Select the **New LanTalk Window for every Session** checkbox if you want a new window for every new LanTalk session.

5. Click **OK** to save the LanTalk settings.
Configuring Notifications

The Notification tab allows you to customize the way that you are notified when you receive new messages and when other users log in to the system.

**Note:** This feature is only available to Advanced or Unified users. For an explanation of the different user types, refer to the *About This Guide* section in this document.

◆ **To configure the notifications:**

1. Log into the 6510 UM Client Manager.

2. Click the **Notification** tab. The Notification dialog appears.

![Notification dialog](image)

- Select the **When new messages arrive, make the icon flash** checkbox to enable the 6510 UM Client Manager icon to flash when you receive a new message.
• Select the **When new messages arrive, popup notification window** checkbox to enable the screen popup that notifies you of new messages.

• Select the **When others log in, popup notification window** checkbox to enable the screen popup that notifies you when other users log in to the system.

3. In the **Sounds** fields, customize the sounds that you wish to use for each function by using the Browse button to select the appropriate sound files within the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Message</td>
<td>Select the sound file you want played when you receive a new message.</td>
</tr>
<tr>
<td>Urgent Message</td>
<td>Select the sound file you want played when you receive an urgent message.</td>
</tr>
<tr>
<td>Record Beep</td>
<td>Select the sound file you want played for the record beep.</td>
</tr>
<tr>
<td>New Call</td>
<td>Select the sound file you want played when you receive a call.</td>
</tr>
<tr>
<td>LanTalk</td>
<td>Select the sound file you want played when you receive a LanTalk message.</td>
</tr>
<tr>
<td>Logged in User</td>
<td>Select the sound file you want played when a user logs in.</td>
</tr>
</tbody>
</table>

**Note:** The Notification Sounds feature only supports sound files in **.wav format.**

4. Click **OK** to save your Notification settings.
Using the UM Call Manager

When a call is directed to your extension through the 6510 Auto Attendant, the UM Client Manager displays a screen pop that displays information about the phone call.

**Note 1:** This feature is only available to Advanced or Unified users. For an explanation of the different user types, refer to the *About This Guide* section in this document.

**Note 2:** The Contacts feature and button will only appear if you set your PIM Integration Settings to use Outlook.

Using the Toolbar Buttons

There are eight buttons that allow you to perform various tasks within the UM Call Manager display.

**Note:** You may not see all of the buttons shown below on your system. The availability of some of the buttons depends on
Using the UM Client Manager and Desktop Applications

the PBX integration of your system. Contact your System Administrator for more information.

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Answer" /></td>
<td>Transfers the call to the active extension that your user account has been defined to. For more information, refer to Chapter 2 (Using the Web Client) in this document. This feature is PBX dependent.</td>
</tr>
<tr>
<td><img src="image" alt="Transfer" /></td>
<td>Transfers the call to another extension. Click the arrow key to define the extensions.</td>
</tr>
<tr>
<td><img src="image" alt="Hold" /></td>
<td>Puts the incoming call on hold. Click the arrow key to select the length of time that the call will be on hold.</td>
</tr>
<tr>
<td><img src="image" alt="Take Msg" /></td>
<td>Sends the call to voice mail. Click the arrow to select what greeting to play the caller.</td>
</tr>
<tr>
<td><img src="image" alt="Recall" /></td>
<td>Allows you to pull a caller out of voice mail while they are leaving a message.</td>
</tr>
<tr>
<td><img src="image" alt="Dial" /></td>
<td>Allows you to dial back a number that left a message or called. You can go into contacts and used the dial button as well. This feature is PBX dependent.</td>
</tr>
<tr>
<td><img src="image" alt="DND ON" /></td>
<td>This button allows you to turn your do not disturb status on or off at any time.</td>
</tr>
<tr>
<td><img src="image" alt="Contacts" /></td>
<td>This launches the embedded UM Client Manager Contact database to log call statistics and dial back. (Only functional in conjunction with Outlook).</td>
</tr>
</tbody>
</table>
Answering a Call

When a call appears on the UM Call Manager display, click **Answer** to transfer the call to your extension.

**NOTE:** The Answer button is disabled until you receive another call.

Recording a Call

The Record Conversation interface can be accessed in the following three (3) ways:

- Right-click the UC Client Manager icon in the system tray. **Record Conversation** is an option:

```
UC Client Manager

WebClient Home ...
My Web Client Settings ...
My Email Client ...
Set Current Location ...
LanTalk ...
Directory ...
UC Call Manager ...
Record Conversation

Options ...
About ...

Logout
Logout & Exit
```

Whenever this option is selected, the Mitel 6510 is directed to use the silent monitor option available on the PBX to listen to the user's conversation. As soon as the call is finished, a message containing the recorded conversation will be deposited in the user's default mailbox.

**NOTE:** A recording session cannot be ended before the actual call ends once the initial request has been initiated.
Using the UM Client Manager and Desktop Applications

- Click the Record icon in Call Manager during a call. As soon as the call is finished, a message containing the recorded conversation will be deposited in the user's default mailbox.

- Via the Mitel 6510 telephone interface. When a call comes in, a user (with Call Screening) is presented with the following options when they are ready to take the call:

  1 - accept call
  2 - send call to another extension
  3 - accept and record conversation
  # - send to mailbox

By pressing [3] the user will take the call and the Mitel 6510 will record the full conversation. As soon as the call is finished, a message containing the recorded conversation will be deposited in the user's default mailbox.
Removing a Call

UM Client Manager gives you the option of removing one or all of the calls on the display.

- **To remove a call:**
  1. Highlight the call to be removed and click **Clear**. A dialog appears, prompting you to confirm the deletion.
  
  **Note:** To remove all calls from the display, click **Clear**.
  2. Click **OK**. UM Client Manager removes the calls from the screen.

Transferring a Call

When a call comes to your extension, you can transfer the call to another extension. After you specify the extension, it will be displayed in the Transfer drop down list and is available to use again.

- **To transfer a call:**
  1. Click the arrow key to select the extension to which to transfer the call. To specify an extension, click **Other**. The Transfer Call dialog appears.
  2. Enter the mailbox number associated to the phone extension that you want to transfer the call to and click **OK**.

  **Note:** The Transfer button is disabled until you receive another call.

Putting a Call on Hold

When a call comes through to your extension, you can put the call on hold until you have an opportunity to answer it.

- **To put a call on hold:**
  1. Click the arrow key beside the Hold button to select the length of time that you want to put the call on hold for. Time selections include **30 seconds**, **1 minute**, **2 minutes**, or **Other**. If you select
Using the UM Client Manager and Desktop Applications

When a call comes through to your extension, you can choose to send the call directly to your voice mail. When enabling this option from the UM Client Manager interface, you can select which pre-recorded greeting to use to greet the caller.

To take a message:
1. Click the Take Msg arrow key and select the greeting type you want the caller to receive. The UM Call Manager sends the caller to the selected greeting to record a message.

Pulling a Caller out of Voicemail

When a caller is in the process of leaving a message in your voice mailbox, you can choose to retrieve the caller from voicemail and speak to them directly.

To pull a caller out of voicemail:
1. While a caller is in a message recording session, click Recall. The caller is transferred to your extension.

Specifying Do Not Disturb

Do Not Disturb (DND) allows you to activate a Do Not Disturb message when an incoming call appears in the popup.

To specify do not disturb:
1. Click the Do Not Disturb icon.

Adding a Call to the Contact Manager
Using the UM Client Manager and Desktop Applications

Note: This function is only available when PIM Integration is set to Outlook.

If your PIM Integration is set to Outlook, after you answer a call, you can add information about the caller to the Microsoft® Outlook Contact Manager. For more information on how to use contacts, see your Outlook guide.

Changing Your Status

The UM Client Manager provides you with the ability to inform callers when you are not available to answer the phone. For example, if you are on holiday, you can instruct the system to inform a caller that you are away and the date when you will be back in the office.

Note: This feature is only available to Advanced or Unified users.

For an explanation of the different user types, refer to the About This Guide section in this document.

If you have recorded personal status greetings, the caller will hear your recorded greeting for the status that you have set.

Note: For information on how to record personal status greetings, refer to the Telephone User Guide.

If you have not recorded personal status greetings, the default system greeting for the status that you have set will play. If you have specified an "Available At" date and time, the system will also play that information.

To change your status:

1. Right-click the UM Client Manager icon, then select Present Status.
2. Select the status that you want activated.

<table>
<thead>
<tr>
<th>Status</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>In Office</td>
<td>Rings your Active extension.</td>
</tr>
<tr>
<td>Busy</td>
<td>Goes to voice mail and plays the busy greeting.</td>
</tr>
<tr>
<td>Meeting</td>
<td>Goes to voice mail and plays the meeting greeting.</td>
</tr>
<tr>
<td>Do Not Disturb</td>
<td>Goes to voice mail and plays the do not disturb greeting.</td>
</tr>
<tr>
<td>Lunch Time</td>
<td>Goes to voice mail and plays the lunch greeting.</td>
</tr>
</tbody>
</table>
Using the UM Client Manager and Desktop Applications

<table>
<thead>
<tr>
<th>Present Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gone Home</td>
<td>Goes to voice mail and plays the gone home greeting.</td>
</tr>
<tr>
<td>Away on Business</td>
<td>Goes to voice mail and plays the away on business greeting.</td>
</tr>
<tr>
<td>Vacation</td>
<td>Goes to voice mail and plays the vacation greeting.</td>
</tr>
<tr>
<td>No Answer</td>
<td>Rings your active extension.</td>
</tr>
</tbody>
</table>

3. If you select a Present Status other than **In Office** or **No Answer**, the following appears:

4. Select the **Available At** check-box to activate the schedule.
5. Specify the date and time you will next be available.

*The selected status will be represented by the corresponding icon in your Windows System Tray.*

**Note 1:** You do not need to specify an Available At date and time. This is an option that you may choose, which, if selected will inform callers of the date and time when you will be available.

**Note 2:** The system does not revert your status greeting back to "in office" when your Available At time is met. The status setting needs to be changed manually.
Using LanTalk

LanTalk is the instant messaging module that allows you to chat with other users over the network. You can reach anyone who is logged into the same network connection as the one that you are using, as well as send SMS messages.

Sending a Message

When logged in, you can send instant messages to others using LanTalk.

♦ To send a message (to a single user):

1. Right-click on the UM Client Manager icon and select **LanTalk**. The LanTalk screen appears.

2. From the **Select Destination** drop-down, select **Select Destination from LanTalk Directory**. The Directory screen appears.
3. Click on the **Company Directory** tab:

4. Double-click on the user you want to message. You are returned to the LanTalk screen.

   **Note:** The LanTalk Directory can also be accessed directly if you right-click on the UM Client Manager icon, select LanTalk and click Directory.

5. Select the **Also Send by SMS** check-box to send to a mobile phone (if applicable).

6. In the lower box enter your message.

   **Note:** You can also select a recipient to whom you have previously sent a message from the Select Destination drop-down list.

7. Click **Send**.
Creating a Broadcast Message

Using the Broadcast Message feature is useful if you want to send the same message to everyone connected to the system.

◆ To create a broadcast message:

1. Right-click on the UM Client Manager icon and select **LanTalk**. The LanTalk screen appears.

2. From the **Select Destination** drop-down, select **Broadcast**. The Directory screen appears.

3. In the lower box enter your message, then click **Send**.
Creating a Buddies List

A Buddies List allows you to create a distribution list for Lan Talk broadcasts. After creating a Buddies List, you must add mailboxes (users) to the list. By creating and defining users on a Buddies List, you can send a broadcast message to the selected "buddies" with one click.

♦ To create a Buddies List:

1. Right-click on the UM Client Manager icon and select **LanTalk > Directory**. The LanTalk Directory (Buddies List tab) appears.

2. Select **Tools > Add Buddies List**. The Add Buddies List dialog appears.
Using the UM Client Manager and Desktop Applications

3. In the **List Number** field, enter the list number that will identify the Buddies List.

4. In the **List Name** field, enter a unique name for the Buddies List.

5. Click **OK**. The Buddies List appears in the Buddies List tab.

![Directory window](image)

- **To rename a Buddies List:**

  1. In the Buddies List tab, select a Buddies List and select **Tools > Rename Buddies List**. The following dialog appears:

     ![Rename Buddies List dialog](image)

     2. Click **Yes**. The Rename Buddies List dialog appears.
3. In the **Enter new name** field, enter the new name for the Buddies List.

4. Click **OK**.

To add mailboxes to the Buddies List:

1. In the Buddies List tab, select the Buddies List and click **Tools>Add Mailbox**. The Add Mailbox dialog appears.

You can either add mailboxes by searching for the mailbox number or by user name:

- Select **By Mailbox Number**.

- In the **Mailbox Number** field, enter the mailbox number to search for.
- Click **Search**. Any mailbox number that is found is displayed.
Using the UM Client Manager and Desktop Applications

OR

- Select **By Name**. The Last Name and First Name fields appear.
- In the **Last Name** field, enter the last name of the user you are searching for.
- In the **First Name** field, enter the first name of the user you are searching for.
- Click **Search**. Any name that is found is displayed.

2. Select the user that you want to add, click **Add to List**, then click **Close**. The user appears in the Buddies List.

3. Repeat steps 1-2 to add all necessary users to your Buddies List.
Deleting Buddies Lists and Mailboxes

You can delete individual mailboxes from Buddies Lists or delete entire Buddies Lists.

♦ To delete a mailbox from a Buddies List:

1. In the Buddies List tab, select a user and select **Tools > Delete Mailbox**. The Delete Mailbox dialog appears.

2. Click **Yes**. The mailbox is removed from the Buddies List.

♦ To delete a Buddies List:

1. In the Buddies List tab, select a Buddies List and select **Tools > Delete Buddies List**. The Delete Buddies List dialog appears.

2. Click **Yes**. The Buddies List is removed.
Sending a Message Using a Buddies List

Once a Buddies List is created and multiple users are assigned to it, you can conveniently create Lan Talk messages that are sent to users specific to the Buddies List that is selected.

◆ Sending a message using a Buddies List:

1. Right-click on the UM Client Manager icon and select **LanTalk > Directory**. The Lan Talk Directory (Buddies List tab) appears.

2. Select the Buddies List to use and click OK. The Select Destination field displays the selected Buddies List.

3. In the empty field, enter the message that you want to send.

4. Select the **Also Send to SMS** checkbox to send to a mobile phone (if applicable).

5. Click **Send** to send the message. The message is sent to all users that are defined in your Buddies List.
Using the Outlook Toolbar

The UM Client Manager Toolbar is integrated into the Microsoft Outlook application, allowing you to send a voice, text, or fax message, as well as set your Present Status and launch LanTalk sessions.

**Note:** In cases where there are multiple Profiles being used on the same Outlook application, only the profile of the user who installs the software has access to the UM Client Manager Toolbar in Outlook.
### Using the UM Client Manager and Desktop Applications

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
<th>Available to</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Image" /></td>
<td>Compose a voice message (New Voice Button)</td>
<td>All users</td>
</tr>
<tr>
<td><img src="image2" alt="Image" /></td>
<td>Compose a text message (New Text Button)</td>
<td>All users</td>
</tr>
<tr>
<td><img src="image3" alt="Image" /></td>
<td>Send a fax message (New Fax Button)</td>
<td>All users</td>
</tr>
<tr>
<td><img src="image4" alt="Image" /></td>
<td>Set your Present Status</td>
<td>Advanced and Unified users</td>
</tr>
<tr>
<td><img src="image5" alt="Image" /></td>
<td>Launch a LanTalk conversation</td>
<td>Advanced and Unified users</td>
</tr>
</tbody>
</table>

Note: In order for message type icons to appear in Outlook (for Integrated Messaging and SMTP Forwarding), you must use the VPIM Client to enable this feature. Follow the directions below.
To enable message type icons in Outlook:

1. In your Windows Taskbar, click **Start > Program Files > Mitel Networks 6510 UM > VPIMClient**. The VPIM Client window appears.

![VPIM Client window](image)

2. Click **Preferences**. The Preferences tab appears.

![Preferences tab](image)

3. Under TNEF, select the **Send Always** radio button.

4. Click **Apply**, and then **OK**. Exit the VPIM Client application.
**Message Tab**

The Message tab allows you to compose voice, text and fax messages.

- **To compose a voice message:**

  1. In Microsoft Outlook, click the **New Voice** button. The New Voice Message tab appears.

  2. In the **To** field, enter the e-mail address that you are sending the message to.

  3. In the **Cc** field, enter the e-mail address that you are carbon copying the message to. (If applicable).

  4. In the **Subject** field, enter the subject for the message.

  5. Under **Choose Message Type**, ensure that **Voice** is selected.

    The sound recording toolbar is used to record and playback voice messages. There are buttons to record, clear, play, stop, rewind, and fast forward the message.
Using the UM Client Manager and Desktop Applications

allows you to adjust the message volume and speed.

6. Click and begin recording the voice message with your microphone. Click when finished recording.

7. Click to verify that you message is recorded. If the message needs to be revised, click to clear the message and re-record your message.

8. In the text field at the bottom of the screen, enter any text that you want included with the message.

9. Click Send. The composed message is sent.

To compose a text message:

1. In Microsoft Outlook, click the New Text button. The New Text Message tab appears.

2. In the To field, enter the e-mail address that you are sending the message to.
3. In the Cc field, enter the e-mail address that you are carbon copying the message to. (If applicable).

4. In the Subject field, enter the subject for the message.

5. Under Choose Message Type, ensure that Text is selected.

6. In the text field at the bottom of the screen, enter your message.

7. Click Send. The composed message is sent.

Note: If you delete a message, the message must be purged in order for it to be removed on the voice mail server. Purging deleted messages in any supported Client application will update the message count status on the voice mail server.
To compose a fax message:

1. In Microsoft Outlook, click the **New Fax** button. The New Fax Message tab appears.

2. In the **To** field, enter the e-mail address that you are sending the message to.

3. In the **Cc** field, enter the e-mail address that you are carbon copying the message to. (If applicable).

4. In the **Subject** field, enter the subject for the message.

5. Under **Choose Message Type**, ensure that **Fax** is selected.

6. Click **Add Attachments**. The Open dialog appears.
7. Select the fax to attach to the message. The selected file appears in the field.

8. In the text field at the bottom of the screen, enter any text that you want included with the message.

9. Click Send. The composed message is sent.
Using the UM Client Manager and Desktop Applications

Telephony Options Tab

The Telephony Options tab allows you to configure the voice format and device options. Correctly configuring these options will allow you to listen to voice messages that are received.

**Note:** Standard users do not have access to the Telephony Options function. For an explanation of the different user types, refer to the *About This Guide* section in this document.

To set telephony options:

1. In Microsoft Outlook, click the **New Voice** button. The New Voice Message tab appears.

2. Click the **Telephony Options** tab. The Telephony Options tab appears.

3. In the **Voice Format** drop-down list, select the voice file format to use for playback.
4. In the **Sound Device** drop-down list, select **Sound Card** to listen to voice messages through the sound card on your desktop and click **Apply**. Or, select **Phone** to listen to voice messages through your telephone. If **Phone** is selected, the **Phone Extension** field appears.

5. Enter your phone extension and click **Apply**. Once this is selected, when a voice message is received and opened in Outlook, the system will call your telephone extension and the voice message will be played on your telephone.

6. Telephony Options are now configured.

**Note:** Voice messages recorded through a microphone on a desktop cannot be played through the **Phone** sound device. It can only be played through the **Sound Card** sound device.
Setting Present Status in Outlook

The UM Client Manager provides you with the ability to inform callers when you are not available to answer the phone. For example, if you are on holiday, you can instruct the system to inform a caller that you are away and the date when you will be back in the office.

**Note:** This feature is only available to Advanced or Unified users. For an explanation of the different user types, refer to the About This Guide section in this document.

If you have recorded personal status greetings, the caller will hear your recorded greeting for the status that you have set.

**Note:** For information on how to record personal status greetings, refer to the Telephone User Guide.

If you have not recorded personal status greetings, the default system greeting for the status that you have set will play. If you have specified an "Available At" date and time, the system will also play that information.

◆ To set present status in Outlook:

1. In the UM Client Manager Status Toolbar (Outlook), click the Present Status drop-down list and select a status.

<table>
<thead>
<tr>
<th>Status</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>In Office</td>
<td>Rings your Active extension.</td>
</tr>
<tr>
<td>Busy</td>
<td>Goes to voice mail and plays the busy greeting.</td>
</tr>
<tr>
<td>Meeting</td>
<td>Goes to voice mail and plays the meeting greeting.</td>
</tr>
<tr>
<td>Do Not Disturb</td>
<td>Goes to voice mail and plays the do not disturb greeting.</td>
</tr>
<tr>
<td>Lunch Time</td>
<td>Goes to voice mail and plays the lunch greeting.</td>
</tr>
<tr>
<td>Gone Home</td>
<td>Goes to voice mail and plays the gone home greeting.</td>
</tr>
<tr>
<td>Away on Business</td>
<td>Goes to voice mail and plays the away on business greeting.</td>
</tr>
<tr>
<td>Vacation</td>
<td>Goes to voice mail and plays the vacation greeting.</td>
</tr>
<tr>
<td>No Answer</td>
<td>Rings your active extension.</td>
</tr>
</tbody>
</table>

2. Your Present Status is set.
Using LanTalk in Outlook

LanTalk is the instant messaging module that allows you to chat with other users over the IP. You can reach anyone who is logged into the same IP as the one that you are using. Integrated into Outlook, LanTalk is much more convenient for you to use to communicate with individuals logged into your network.

**Note:** This feature is only available to Advanced or Unified users. For an explanation of the different user types, refer to the About This Guide section in this document.

◆ **To use LanTalk in Outlook:**

1. In the UM Client Manager Status Toolbar (Outlook), click LanTalk and select **Launch**, **Broadcast**, or **Directory**.
   - To Launch a message, refer to **To send a message (to a single user):** on page 61
   - To Broadcast a message, refer to **To create a broadcast message:** on page 63
   - To use the Directory, proceed.
2. Click **Directory**. The LanTalk Directory (Select Destination) dialog appears.
3. Highlight a user and click **OK**. The LanTalk dialog displays the user’s information.
4. From the **Send Text** drop-list, enter the message that you want to send.

**Note:** You can also select a previous message that you sent.

5. Click **Send** to send the message.
6. Click **Clear** to clear the current conversation off of your IM screen.
Using UM Client Manager Forms in Lotus Notes

If you selected to install Lotus Notes forms when installing the UM Client Manager, you can use these forms in your Lotus Notes application. These forms provide you with the ability to send and receive Fax, Text, and Voice messages in your Lotus Notes application.

◆ **To use forms in Lotus Notes:**

1. Open the Lotus Notes application. The Lotus Notes window appears:
2. Click **Mail**. Your Inbox appears:

![Image of Mail Inbox]

3. In the Lotus Notes toolbar, click **Create**. A drop-down list appears:

![Image of Create options drop-down]

4. The UM Client Manager forms provide you with the following new options: Fax Message, Text Message, and Voice Message.

Select one of the options to create either a Fax, Text, or Voice message.

To compose a voice message:

1. In Lotus Notes, select **Create>Voice Message**. The Messages window appears:

2. In the **To** field, enter the e-mail address(es) of the person(s) you are sending the message to.

3. In the **Cc** field, enter the e-mail address(es) of the person(s) you are carbon copying the message to.

   **NOTE: This field is optional.**

4. In the **Subject** field, enter the subject for the message.

5. In the **Record Device** drop-down list, select the device that you are using to record the voice message.
Using the UM Client Manager and Desktop Applications

The sound recording toolbar is used to record and playback voice messages. There are buttons to record, clear, play, stop, rewind, and fast forward the message.

6. Click to begin recording the voice message with your microphone.

Click when you are finished recording.

7. Click to verify that your message has been recorded.

8. In the text field at the bottom of the screen, enter any text you want included with the voice message.

9. Click Send. The composed message is sent.

To compose a text message:

1. In Lotus Notes, select Create>Text Message. The Messages window appears:

2. In the To field, enter the e-mail address(es) of the person(s) you are sending the message to.
Using the UM Client Manager and Desktop Applications

3. In the **Cc** field, enter the e-mail address(es) of the person(s) you are carbon copying the message to.

**NOTE:** This field is optional.

4. In the **Subject** field, enter the subject for the message.

5. In the text field at the bottom of the screen, enter your message.

6. Click **Send**. The composed message is sent.

**To compose a fax message:**

1. In Lotus Notes, select **Create > Fax Message**. The Messages window appears:

   ![Fax Message Window](image)

   2. In the **To** field, enter the e-mail address(es) of the person(s) you are sending the message to.

   3. In the **Cc** field, enter the e-mail address(es) of the person(s) you are carbon copying the message to.

   **NOTE:** This field is optional.

   4. In the **Subject** field, enter the subject for the message.

   5. Click **Add Attachments**.
6510 UM Client Application Installation and User Guide

Using the UM Client Manager and Desktop Applications

6. Select the fax to attach to the message. The selected file appears in the field.

7. In the text field at the bottom of the screen, enter any text that you want included with the message.

8. Click Send. The composed message is sent.

Processing Attachments in Lotus Notes

◆ To process a voice message attachment:

1. Enter your Lotus Notes inbox from the main application window:
2. Double-click the mail entry containing the voice message you wish to access. The Mail window opens:

3. Double-click the voice message icon. The Attachment dialog box appears:
4. You have several Attachment Actions options from this dialog:

- Click **View**. The File Viewer tab opens, where you can listen to your message:

![File Viewer tab](image)

- Click **Open**. The message will be launched by your system's default media player:

![Media Player](image)
Using the UM Client Manager and Desktop Applications

- Click **Edit**. The message will be launched by your system’s default media player.

- Click **Save**. The Save Attachment dialog box opens:

Choose a location and a filename and click **Save**.

- Click **Delete**. Click **Yes** if you want to go through with the deletion and **No** if you are not sure.
To process a text message attachment:

1. Enter your Lotus Notes inbox from the main application window.
2. Double-click the mail entry containing the text message you wish to access. The Mail window opens:

3. Double-click the text message icon. The Attachment dialog box appears:

You have several Attachment Actions options from this dialog:
Using the UM Client Manager and Desktop Applications

• Click **View**. The File Viewer tab opens, where you can view your message:

![File Viewer](image1.png)

• Click **Open**. The message will be launched by your system’s default text viewing application:

![Notepad](image2.png)

• Click **Edit**. The message will be launched by your system’s default text viewing application.
Using the UM Client Manager and Desktop Applications

- Click **Save**. The Save Attachment dialog box opens:

![Save Attachment dialog box](image)

Choose a location and a filename and click **Save**.

- Click **Delete**. Click **Yes** if you want to go through with the deletion and **No** if you are not sure.

◆ **To process a fax message attachment:**

1. Enter your Lotus Notes inbox from the main application window:
2. Double-click the mail entry containing the fax message you wish to access. The Mail window opens.
3. Double-click the fax message icon. The Attachment dialog box appears.
4. You have several Attachment Actions options from this dialog:
   - Click **View**. The File Viewer tab opens, where you can view your fax message.
   - Click **Open**. The message will be launched by your system’s default text viewing application.
Using the UM Client Manager and Desktop Applications

- Click **Edit**. The message will be launched by your system's default text viewing application.

- Click **Save**. The Save Attachment dialog box opens. Choose a location and a filename and click **Save**.

- Click **Delete**. Click **Yes** if you want to go through with the deletion and **No** if you are not sure.
In This Chapter . . .

Overview on page 98
Starting Web Client on page 98
Web Client Functions on page 102
Using the Inbox on page 103
Maintaining Folders on page 121
Maintaining the User Settings on page 126
Maintaining Message Options on page 136
Maintaining Call Options on page 142
Maintaining Addresses on page 145
Maintaining a Distribution List on page 157
Maintaining Notifications on page 160
Maintaining Wakeup Calls on page 169
Maintaining Greetings on page 171
Using the Collaborate Feature on page 176
Overview

Web Client is a web-based interface that provides you with access to your 6510 UM account and features over the Internet. You can check your e-mails, phone messages, and faxes from anywhere in the world.

Note: This application is only available to Advanced or Unified users. For an explanation of the different user types, refer to the About This Guide section in this document.

Starting Web Client

Running Grant Permissions

Executing Grant Permissions allows each new user to utilise all available functions in the Web Client (such as recording voice messages).

Make sure that you first run the Grant Permissions from the Web Client screen before logging in to the Web Client.

Note: You may have already enabled Grant Permissions during the installation of the client applications. Skip this procedure if you have already enabled this function.

◆ To run Grant Permissions:

1. Open your browser (using Microsoft Explorer 6.0 or greater or Netscape Navigator 6.2 or greater). The Web Client screen appears.

2. In the Address field, enter the IP address of the 6510 UM server, and then click Go.

Note: If you do not know the IP address, contact your Network Administrator.


4. In the Getting Started drop-down list, select Grant Permission.
5. Click **Go**. The File Download dialog appears.

6. Click **Open**. The Grant Permissions Installation begins, and the Set Client-Side Permissions dialog appears.

7. In the http:// field, enter the IP address of your web server, and then click **OK**. The Grant Permission dialog appears.

8. Click **OK**. Grant Permissions is now complete. You can proceed to logging in and using the Web Client.
Connecting to the Web Client

In order to access your 6510 UM account over the Internet, you must first start the Web Client.

**Note:** Before using this application, make sure that SSL has been enabled on the Web Client. Check with your System Administrator if you are not sure if this has been done.

◆ To connect to the Web Client:

1. Open your browser (using Microsoft Explorer 6.0 or greater or Netscape Navigator 6.2 or greater). The Web Client screen appears.

2. In the **Address** field, enter the IP address of the UM server followed by /um and click **Go**.

**Note:** If you do not know the proper IP address, contact your Network Administrator.


4. Select a language interface from the selection on the left hand side.

**Note:** The default is English.

5. In the **Mailbox** field, enter your mailbox number.

6. From the **Company** drop down list, select a company (if there are multiple companies in the UM system).

7. In the **Password** field, enter your password and click **Login**. The Top\Inbox\ screen appears.

**Note:** If you are accessing the Web Client from your computer where the UM Client Manager is installed, then you may right-click on the Client Manager icon and select My UM Inbox to launch your Web Client mailbox.
Using the Web Client

Logging Off

After finishing the Web Client session, you must log off.

◆ To log off:
  1. Click **Log Off**. A message appears prompting you to confirm log off action.
  2. Click **OK**. The Web Client screen appears.
Web Client Functions

Using the Scroll Buttons

Scroll buttons allow you to scroll through the display of messages.

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>←</td>
<td>First Record</td>
<td>Scrolls to the first record</td>
</tr>
<tr>
<td>←</td>
<td>Previous Record</td>
<td>Scrolls to the previous record</td>
</tr>
<tr>
<td>→</td>
<td>Next Record</td>
<td>Scrolls to the next record</td>
</tr>
<tr>
<td>→</td>
<td>Last Record</td>
<td>Scrolls to the last record</td>
</tr>
</tbody>
</table>

**Note:** Scroll buttons appear in both the Inbox and Folders applications.

Using the Main Toolbar Functions

The left hand side of the screen displays the main toolbar functions.

<table>
<thead>
<tr>
<th>Toolbar Function</th>
<th>Name</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Inbox</td>
<td>Displays all of your messages</td>
</tr>
<tr>
<td></td>
<td>Folders</td>
<td>Displays your folders</td>
</tr>
<tr>
<td></td>
<td>User Settings</td>
<td>Configure your user properties</td>
</tr>
<tr>
<td></td>
<td>Distribution List</td>
<td>Create and edit your distribution lists</td>
</tr>
</tbody>
</table>
**Using the Web Client**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📢</td>
<td>Notification</td>
<td>Sets up and configures notification properties on new messages</td>
</tr>
<tr>
<td>🕒</td>
<td>Wakeup Call</td>
<td>Setup and configure a wakeup call</td>
</tr>
<tr>
<td>🎤</td>
<td>Greetings</td>
<td>Record and edit greetings</td>
</tr>
<tr>
<td>🖥️</td>
<td>Collaboration</td>
<td>Initiates the defined collaboration service</td>
</tr>
<tr>
<td>✅</td>
<td>Log Off</td>
<td>Log off of Web Client</td>
</tr>
</tbody>
</table>

**Using the Inbox**

The Inbox displays all of the voicemails, faxes, and e-mails that have been sent to your mailbox.

*Note:* If you are a first-time Web Client user with IMAP TSE Gateway access, a significant amount of time is required for your existing messages (if there is a large amount) to be propagated to your Web Client inbox.
**Message Icons**

There are seven message icons used to represent information about each message in the Inbox.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>🎤</td>
<td>Voice</td>
<td>Indicates a voice message that you have not listened to</td>
</tr>
<tr>
<td>🎤</td>
<td>Voice</td>
<td>Indicates a voice message that you have listened to</td>
</tr>
<tr>
<td>💌</td>
<td>E-mail</td>
<td>Indicates an e-mail that you have not read</td>
</tr>
<tr>
<td>💌</td>
<td>E-mail</td>
<td>Indicates an e-mail that you have read</td>
</tr>
<tr>
<td>📄</td>
<td>Fax</td>
<td>Indicates a fax message</td>
</tr>
<tr>
<td>⚠️</td>
<td>Importance</td>
<td>Indicates the importance of the message</td>
</tr>
<tr>
<td>🔄</td>
<td>Private / Certified</td>
<td>Indicates that the message cannot be forwarded to another user. The icon also indicates that you will receive a message in your Inbox when the recipient has listened to your voice message.</td>
</tr>
</tbody>
</table>
Displaying Messages by Type

You can display the messages in any folder either by type or all messages together. The default is Show All.
Using the Web Client

Using the Toolbar Buttons

There are nine buttons that allow you to perform various tasks within the Inbox.

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Compose new message</td>
<td>Compose a new voice message, e-mail, or fax</td>
</tr>
<tr>
<td></td>
<td>Reply</td>
<td>Reply to the message</td>
</tr>
<tr>
<td></td>
<td>Forward</td>
<td>Forward the message to another user.</td>
</tr>
<tr>
<td></td>
<td>Refresh</td>
<td>Refresh the display</td>
</tr>
<tr>
<td></td>
<td>Copy marked items</td>
<td>Copy a marked item</td>
</tr>
<tr>
<td></td>
<td>Move marked items</td>
<td>Move a marked item</td>
</tr>
<tr>
<td></td>
<td>Delete marked items</td>
<td>Delete a marked item</td>
</tr>
<tr>
<td></td>
<td>Add</td>
<td>Add a recipient</td>
</tr>
<tr>
<td></td>
<td>Remove</td>
<td>Remove a recipient</td>
</tr>
</tbody>
</table>
Using the Web Client

Playing a Voice Message

Using Web Client, you can play back any voice mail message that has been sent to your mailbox. If there are any attachments to the voice message, Web Client will download the files to your PC.

**Note:** The Java Plug-In and Grant Permissions must have been installed on the computer you are using in order to be able to play and record voice mail messages.

♦ **To play a voice message:**

1. In your **Inbox**, click the icon beside the voice message that you want to hear. The Voice Message From dialog appears.
Using the Web Client

The Windows Sound Player becomes active and plays the message automatically.

2. From the List of Attachments drop down list, select an attachment, then click Open. The Save As dialog appears.

3. Select a directory to save the file to, then click Save. When the download is complete, click Close.

4. To return to the Inbox, close the window.

Correcting a Voice Message Play Error

Due to a known sound card driver problem specific to certain sound cards, the applet may crash if the Playback Speed bar is dragged when playing a message in Web Client. If this error occurs, the error can be corrected.

◆ To correct a voice message play error:

1. In your Windows Desktop, click Start>Settings>Control Panel. The Control Panel window appears.


3. Click the Audio tab and under the Sound Playback box, click the Advanced button. The Advanced Audio Properties dialog appears.

4. Click the Performance tab. The Performance tab appears.

5. In the Hardware Acceleration section, drag the bar to None and click OK. The Sounds and Multimedia Properties dialog appears.

6. Under the Sound Recording box, click the Advanced button. The Advanced Audio Properties dialog appears.

7. Repeat step 5 above and click OK.

Using the Web Client

Viewing a Fax

If you have Fax Client installed on your PC, you can view any fax that has been sent to your mailbox.

◆ To view a fax:

1. In your Inbox, click the Fax icon. The fax message appears.
2. Select the fax from the List of Attachments drop-down list if the fax is an attachment in the message. The fax message appears.

Reading an E-mail

Web Client gives you the ability to read your e-mails either in the office or from anywhere in the world.

◆ To read an e-mail:

1. In your Inbox, click the E-mail icon. The following dialog appears.
Using the Web Client

2. From the **List of Attachments** drop down list, select an attachment, and click **Open**. The Save As dialog appears.

3. Select a directory to save the file to, then click **Save**. When the download is complete, click **Close**.

4. To return to the Inbox, close the window.

**Refreshing the Display**

Web Client refreshes the display automatically so that the most recent messages always appear in your Inbox. However, you can also refresh the display manually by clicking **Refresh**.

**Composing a Message**

Web Client gives you the ability to compose one of three types of messages: Voice, Text, or Fax. The message can then be sent to the following types of users:

- UM
- VPIM
- AMIS
- E-mail

In addition, you can also send the mail to a Distribution list.
Creating a Voice Message

If you have a microphone attached to your PC, you can use Web Client to send a voice message.

To create a voice message:

1. In your Inbox, click New in the toolbar.

2. Select Voice and click OK. The voice dialog appears.

3. From the Importance drop down list, select Normal or High (Urgent) to specify the importance of the voice message.

4. Select Certified if you want to receive a message that the recipient has listened to your voice message.
Using the Web Client

5. Select **Private (Not Forwardable)** to prevent the receiver from forwarding the voice mail message to another user.

6. Click **Attachments** if you want to attach a file to the voice message.

7. Click **To** to specify the recipients. The To dialog appears.

   **Note:** You can also enter the recipient’s extension.

8. Highlight a recipient, then click the **Add** arrow. When you have finished adding all of the recipients, click **OK**. The From dialog appears.

9. In the **Subject** field, enter the subject of the voice message.

10. Click **Record** to record the voice message. Click **Stop** when you have finished recording. Click **Play** to review the voice message.

11. Click **Send**.

Web Client keeps a copy of your voice message in the Sent folder.
Creating a Text Message

You can use Web Client to create a text message.

Note: There is no limit to the length of the text message.

To create a text message:

1. In your Inbox, click New in the toolbar.

2. Select Text, then click OK. The text dialog appears.
Using the Web Client

3. From the Importance drop down list, select Normal or High (Urgent) to specify the importance of the text message.

4. Select Certified if you want to receive a message in your Inbox that the recipient has read your text message.

5. Select Private (Not Forwardable) to prevent the receiver from forwarding the text mail message to another user.

6. Click Attachments if you want to attach a file to the text message.

7. Click To to specify the recipients. The To dialog appears.

8. Highlight a recipient and click the Add arrow. When you have finished adding all of the recipients, click OK.

9. Enter the text message and click Send.

Web Client keeps a copy of your voice message in the Sent folder.

Creating a Fax Message

You can create fax messages to send to your contacts.

- To create a fax message:

1. In your Inbox, click New in the toolbar.

2. Select Fax and click OK. The fax dialog appears.
Using the Web Client

3. From the Importance drop down list, select Normal or High (Urgent) to indicate the importance of the message.

4. Select Certified if you want to receive a message in your Inbox that the recipient has read your message.

5. Select Private (Not Forwardable) to prevent the receiver from forwarding the message to another user.

6. Click Attachments if you want to attach a file to the message.

7. Click To to attach recipients to the fax. The To dialog appears.

8. Highlight a recipient and click the Add arrow. When you have finished adding all of the recipients, click OK. The From dialog appears.

9. In the Subject field, enter the subject of the fax.

10. In the Fax File field, enter the file you want to send and click Send.

Adding an Attachment to a Message

Web Client allows you to add one or more attachments to your voice, text, or fax message.

To add an attachment:

1. While composing any type of message in the From dialog, click Attachments. The Attachments dialog appears.

2. In the Attach File field, enter the directory and name of the file and click Add.

   **Note:** Click Browse to navigate to a directory.

3. Highlight the file, then click Remove to remove the file.

4. Click Clear All to remove all of the attached files.

5. Repeat step 2 to add another file, or click OK to return to the From dialog.
Using the Web Client

Replying to a Message

After you have read a message, you can reply to the sender with a comment using Voice, Text, or Fax. You can also forward a copy of the message to another user and include your comments.

To reply to a message:

1. To reply to a message from the Inbox, select the check box beside it and click **Reply**.

   **Note:** You can only reply to one message at a time.

2. If you are reading the e-mail, listening to a voice message, or viewing a fax, click **Reply**. The Reply dialog appears.

3. Select the method that you want to use to reply to the message and click **OK**. Depending on the reply method you selected, the appropriate dialog appears.

4. Complete the dialog and click **Send**. Web Client puts a copy of the message to each user in your Sent folder.
Forwarding a Message

You can forward a message either from the Inbox or while you are reading it.

◆ To forward a message:

1. Select the check box beside the message that you want to forward, then click **Forward**.

   **Note:** You can only forward one message at a time.

2. If you are reading the e-mail, listening to a voice message, or viewing a fax, click **Forward**. The Forward dialog appears.

3. Select **Add Comment** if you want to add a comment and click **OK**. The Voice, Text, and Fax options become active.

4. Select the method that you want to use to reply to the message and click **OK**. Depending on the reply method you selected, the appropriate dialog appears.

5. Complete the dialog and click **Forward**. Web Client puts a copy of the forwarded message to each user in your Sent folder.

Copying a Message

Web Client allows you to copy one or more messages and store them in another folder. This is useful if you would like to have copies of your messages stored in more than one folder.

You can copy messages either from the Inbox (if you want to copy more than one), or after you have read it.

◆ To copy one or more messages:

1. Select the folder containing the messages that you want to copy.

2. Beside each message, select its check box, then click **Copy marked items**. If you are reading the message, click **Copy to another folder**. The Copy marked items dialog appears.
Using the Web Client

3. Select the folder to copy the messages to, then click **OK**. The folder that you copied the messages to appears on the desktop. The folder that you copied the messages from still contains the original messages that you copied.

Moving a Message

Web Client allows you to move one or more messages from one folder to another. This is useful if you want to sort your messages by sender or subject.

- **To move one or more messages:**

  1. Select the folder containing the messages that you want to move.

  2. Beside each message, select its check box, then click **Move marked items**. If you are reading the message, click **Move to another folder**. The Copy marked items dialog appears.
3. Select the folder to move the messages to, then click **OK**. The folder that you moved the messages to appears on the desktop.

**Deleting a Message**

Once you have read a message, you can delete it from its folder.

- **To delete one or more message:**
  1. Select the folder containing the messages that you want to delete.
  2. Beside each message, select its check box, then click **Delete marked items**. If you are reading the message, click **Delete**.

Web Client removes the messages from the folder and puts them into the Deleted Items folder.
Maintaining Folders

You can create an unlimited number of folders to help organize your voice messages, e-mails, and faxes.

Using the Toolbar Buttons

There are six buttons that allow you to perform various tasks within the Folders application.

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Folder Icon]</td>
<td>Create a new folder</td>
<td>Creates a new folder</td>
</tr>
<tr>
<td>![Folder Icon]</td>
<td>Delete the current folder</td>
<td>Deletes the current folder</td>
</tr>
<tr>
<td>![Folder Icon]</td>
<td>Rename the current folder</td>
<td>Renames the current folder</td>
</tr>
<tr>
<td>![Folder Icon]</td>
<td>Copy the current folder</td>
<td>Copies the current folder</td>
</tr>
<tr>
<td>![Folder Icon]</td>
<td>Move the current folder</td>
<td>Moves the current folder</td>
</tr>
<tr>
<td>![Folder Icon]</td>
<td>Empty Deleted Folder</td>
<td>Removes the contents of the Deleted folder</td>
</tr>
</tbody>
</table>

Creating a New Folder

You can create a new folder to be at the same level as the default folders or to be a sub-folder.

**Note:** If you want the new folder to be a sub-folder, select the parent folder first.

◆ To create a new folder:

1. Click **Create a new folder**. The New Folder dialog appears.
2. Enter the name of the new folder, then click **OK**. Web Client displays the folders in alphabetical order.

**Deleting a Folder**

You can delete any folder that you have created, with the exception of the five default folders.

**Caution:** Deleting a folder deletes the contents of that folder, including all sub-folders.

- **To delete a folder:**
  1. Click on the folder that you want to delete.
  2. Click **Delete the current folder**. A message appears, prompting you to confirm deletion.
  3. Click **OK**. Web Client removes the directory from the display.

**Renaming a Folder**

You can rename any of existing folders.

**Note:** You cannot rename any of the default folders.

- **To rename a folder:**
  1. Click **Rename the current folder**. The Rename Folder dialog appears.
Using the Web Client

3. Enter the new name of the folder, then click OK. Web Client displays the new name of the folder.

Copying a Folder

You can copy an existing folder to another folder. For example, you could have two folders both named “Budgets.” One budget folder could be in the “This Year” folder, while the other budget folder could be in the “Next Year” folder.

Note: You cannot copy any of the folders that come installed with Web Client.

◆ To copy a folder:

1. Click Folders, then select a folder.

2. Click the Copy the current folder icon. The Copy the Current Folder dialog appears.
3. Select a folder to copy the folder to, then click OK. The folder is copied to the indicated folder.

**Moving a Folder**

You can move folders to other folders and directories.

**Note:** You cannot move the five default folders.

- **To move a folder:**
  1. Select a folder.
  2. Click **Move the current folder**. The Move the current folder dialog appears.
Using the Web Client

3. Select where you want to move the folder and click OK. Web Client displays the folder directory tree with the selected folder moved into the new position.

Recovering Deleted Messages

Each time you delete a voice message, e-mail, or fax message, Web Client stores the message in the Deleted Items folder. This allows you to recover deleted messages if you change your mind about deleting one or more messages, you can move them from the Deleted Items folder to another folder.

To recover a deleted message:

1. Click Folders, then Deleted Items. The Deleted Items dialog appears.

2. Select the check box beside each message that you want to keep, then click Move marked items. The Move marked items dialog appears.

3. Select the folder to store the recovered messages and click OK. Web Client moves the deleted messages into the selected folder.
Emptying the Deleted Items Folder

Emptying the Deleted Items folder removes all of the deleted messages and folders from Web Client permanently.

Caution: Once you empty the Deleted Items folder, you cannot recover the deleted messages.

To empty the Deleted Items folder:

1. Click Inbox or Folders.
2. Click Empty Deleted Folder. A message appears, prompting you to confirm deletion.
3. Click OK. The system deletes all items stored in the Deleted Items folder.

Maintaining the User Settings

The User Settings function allows you to maintain your mailbox on Web Client. You can specify a number of settings including:

- General Options
- Message Options
- Call Options
- Addresses
Using the Toolbar Buttons

There are 12 buttons that allow you to perform various tasks within the User Settings application.

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Save]</td>
<td>Save</td>
<td>Saves the mailbox</td>
</tr>
<tr>
<td>![Refresh]</td>
<td>Refresh</td>
<td>Refreshes the display</td>
</tr>
<tr>
<td>![Schedule (Status)]</td>
<td>Schedule (Status)</td>
<td>Create a status schedule</td>
</tr>
<tr>
<td>![Schedule (Phone Addresses)]</td>
<td>Schedule (Phone Addresses)</td>
<td>Create a Phone Addresses Schedule</td>
</tr>
<tr>
<td>![Schedule (E-mail Address)]</td>
<td>Schedule (E-mail Address)</td>
<td>Create a E-mail address schedule</td>
</tr>
<tr>
<td>![Schedule (Fax Number)]</td>
<td>Schedule (Fax Number)</td>
<td>Create a Fax Number schedule</td>
</tr>
<tr>
<td>![Add]</td>
<td>Add</td>
<td>Add a phone address</td>
</tr>
<tr>
<td>![Remove]</td>
<td>Remove</td>
<td>Remove a phone address</td>
</tr>
<tr>
<td>![Edit]</td>
<td>Edit</td>
<td>Edit a phone address</td>
</tr>
<tr>
<td>![Delete all]</td>
<td>Delete all</td>
<td>Delete all mailboxes</td>
</tr>
<tr>
<td>![Add Item]</td>
<td>Add Item</td>
<td>Adds item</td>
</tr>
<tr>
<td>![Delete item]</td>
<td>Delete item</td>
<td>Deletes item</td>
</tr>
</tbody>
</table>
Specifying General Options

The General options screen allows you to specify:

- your presence status
- your passwords
- collaboration services

Specifying your Presence Status

Web Client provides you with the ability to inform callers when you are not available to come to the phone. For example, if you are on holidays, you can instruct the system to inform a caller that you are away and the date when you will be back in the office.

**Note: The Web Client setting overrides the setting that you specified in the UM Client Manager.**

If you have recorded personal status greetings, the caller will hear your recorded greeting for the status that you have set.

**Note: For information on how to record personal status greetings, refer to the Telephone User Guide.**

If you have not recorded personal status greetings, the default system greeting for the status that you have set will play. If you have specified an "Available At" date and time, the system will also play that information.
Using the Web Client

To specify your presence status:

1. Click User Settings. The User Settings screen appears.
2. Click Status. The Status screen appears.
3. From the Status drop-down list, select your current status. An appropriate greeting will play for each status.
4. Select Available at if you want to specify a time when you will be available. In the year, month, day, hour, and min fields, enter the date and time when the selected status takes affect.
5. Click Save.

Creating a Status Schedule

Web Client provides you with the capability to create a schedule specifying when a particular status greeting is played. For example, you can specify that the “In Office” greeting plays Monday to Friday, between 9 am and 5 pm.

Note: The status schedule that you define and activate may become de-activated if you manually set your status using the Web Client, Client Manager, or the Outlook Plug-in. After manually changing your status, return to your status schedule to re-activate your automated status settings.
To create a status schedule:

1. Click **Schedule**. The Status Schedule dialog appears.

![Status Schedule -- Web Page Dialog](image)

**Note:** Web Client automatically activates the schedule.

2. From the **Default** drop down list, select the default status greeting that will run if the schedule expires.

3. From the **From - year, month, and day** drop down list, select the year, month, and day when you want the voice menu to start playing.

4. From the **To - year, month, and day** drop down list, select the year, month, and day when you want the voice menu to end playing.

**Note:** Select All Day if you want the voice menu to play all day.

5. Enter the **From** and **To** hours, in military format. For example, if your company wants the voice menu to play from 9:00 AM to 5:00 PM, set the hours as **From 09:00** and **To 17:00**. If no time is entered, the system will assume all hours.

**Note:** A value of From 13:00 to blank indicates 1:00 PM to midnight.

The maximum value is 23:59 and the minimum value is 0:00.
Using the Web Client

Other than a Blank value, the From field cannot be greater than the To field.

6. Select the days of the week on which the greeting is to play.

Note: If you want the message to run every day, select Every day.

7. From the Status drop down list, select the greeting that will run.

8. Click OK.

Editing a Status Schedule

The status schedule that you create can be edited at any time.

◆ To edit a status schedule:

1. Click Schedule. The Status Schedule dialog appears.

2. Click the scroll bars to display the status schedule that you want to edit.

3. Make the necessary changes, then click OK.

4. Repeat steps 2 and 3 to edit another status schedule, or click OK to return to the General dialog.
Deleting a Status Schedule

The status schedule that you create can be deleted any time.

◆ To delete a status schedule:

1. Click Schedule. The Status Schedule dialog appears.
2. Click the scroll bars to display the status schedule that you want to delete and click Delete Item. A message appears, prompting you to confirm deletion.

Note: Click Delete All to delete all of the Status Schedules.

3. Click OK.
4. Repeat steps 2 and 3 to delete another status schedule, or click OK to return to the General dialog.

Specifying a Password

When you login to the Web Client, the system prompts you for a password.

◆ To specify a password:

1. Click User Settings. The User Settings screen appears.
2. Click Passwords. The Password screen appears.
Using the Web Client

3. In the Numeric Password section enter a password in the **Password** field.
4. Enter the password again in the **Confirm Password** field and then click **Save**.

Specifying a POP3 / IMAP4 Password

POP3 is a protocol used by Web Client to retrieve your messages from the server. If your system is not using POP3, it will use IMAP4. If your system is using either POP3 or IMAP4, you must specify a password for authentication.

- **To specify a password for POP3 or IMAP4:**
  1. In the Password screen, under the POP3/IMAP Settings section, enter a user name in the **User Name** field.

     **Note:** The IMAP user name is the e-mail account user name that is set on the Exchange server (in the Active Directory). See your System Administrator if you do not know your IMAP user name.

  2. In the **Password** field, enter a password for the user name.
  3. In the **Confirm Password** field, enter the password again.
  4. Click **Save**.

Specifying Collaboration

The Collaboration feature allows you to link to your desired Collaboration or Meeting services. You can either specify a Company defined service, or a User defined service. By default, the system is set to a Company defined service and the WebEx website. You can choose to identity an alternate service by selecting the User defined feature, and entering the corresponding personal collaboration url.

- **To specify the collaboration service:**
  1. Click **User Settings**. The User Settings (General) screen appears.
  2. Click **Collaboration**. The Collaboration screen appears.

     **Note:** By default, the system is already set to use the Company defined service (WebEx).
Using the Web Client

3. In the **Active Collaboration Service** drop-down list, select User Defined Services. The User Defined Services field appears.

4. In the **User Defined Services** field, enter the URL for the service that you want to use.

5. Click **Save**.

**Specifying IMAP Settings**

IMAP settings allow you to enable IMAP synchronization and unlock your user account.

◆ **To set IMAP settings:**

1. Click **User Settings**. The User Settings (General) screen appears.
2. Click **IMAP Settings**. The IMAP Settings screen appears.
3. If the **Locked** checkbox is selected, it means that the system does not currently accept the IMAP user login information. Deselect the checkbox to unlock the account.

4. In the **User Name** field, enter the IMAP user name.

5. In the **Password** field, enter the IMAP user’s password.

6. In the **Confirm Password** field, re-enter the IMAP user’s password for verification.

7. Click **Save**.
Maintaining Message Options

Message Options allow you to specify message sorting and order, message forwarding, and playback/record devices.

Sort/Order Messages

The Sort/Order messages feature allows you to specify the in order in which messages should be played.

◆ To sort/order messages:

1. Click **User Settings**. The User Settings (General) screen appears.
2. Click **Sort/Order**. The Sort/Order screen appears.
3. Select **LIFO** or **FIFO**.

<table>
<thead>
<tr>
<th>Message Playback</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>FIFO</strong> (First In, First Out)</td>
<td>FIFO plays the oldest message first and the newest message last.</td>
</tr>
<tr>
<td><strong>LIFO</strong> (Last In, First Out)</td>
<td>LIFO plays the newest message first.</td>
</tr>
</tbody>
</table>

4. Click **Save**.
Using the Web Client

Specifying MessageForwarding

Web Client allows you to forward your messages to another mailbox, distribution list, AMIS or VPIM account, or an e-mail account. This is useful if you want to designate where certain messages should be forwarded. Before specifying any e-mail addresses, ensure that the e-mail client used for that address does not block .wav file attachments and that the client machine has a device installed that can play .wav attachments.

◆ To specify message forwarding:

1. Click User Settings. The User Settings (General) screen appears.

2. Click Message Forwarding. The Message Forwarding screen appears.

3. From the Address Type drop down list, select an address type. Depending on the address type you select, you must follow the corresponding steps listed in the following:
Using the Web Client

For Mailbox and Distribution List:

1. In the Address drop-down list, select the mailbox or distribution list to use.

2. In the After Hour(s)/Minute(s) fields, enter when message forwarding should be enabled.

3. Select the Delete After Forward checkbox to delete each message after forwarding.

Caution: If the Delete After Forward option has been selected, the message will be permanently deleted from your mailbox on the 6510 system. In the event that the delivery was unsuccessful, and the message does not arrive at its designated destination, the message is still accessible from your SENT folder (if you have Web Client access), or you may contact your System Administrator to retrieve the message from your SENT folder on your behalf.

For AMIS or VPIM:

1. In the Remote Sites drop-down list, select the remote site.

2. In the Address field, enter the remote mailbox to use.

3. In the After Hour(s)/Minute(s) fields, enter when message forwarding should be enabled.

4. Select the Delete After Forward checkbox to delete each message after forwarding.

Caution: If the Delete After Forward option has been selected, the message will be permanently deleted from your mailbox on the 6510 system. In the event that the delivery was unsuccessful, and the message does not arrive at its designated destination, the message is still accessible from your SENT folder (if you have Web Client access), or you may contact your System Administrator to retrieve the message from your SENT folder on your behalf.
For **E-mail**: 

1. In the **Address** field, enter the e-mail address to use.
2. In the **After Hour(s)/Minute(s)** fields, enter when message forwarding should be enabled.
3. Select the **Delete After Forward** checkbox to delete each message after forwarding.

**Caution:** If the Delete After Forward option has been selected, the message will be permanently deleted from your mailbox on the 6510 system. In the event that the delivery was unsuccessful, and the message does not arrive at its designated destination, the message is still accessible from your SENT folder (if you have Web Client access), or you may contact your System Administrator to retrieve the message from your SENT folder on your behalf.

4. Click **Save**.

**Specifying Playback/Record Options**

The Playback/Record Options feature allows you to specify message playback options as well as indicate the playback and record devices.

- **To specify message playback/record options:**
  1. Click **User Settings**. The User Settings (General) screen appears.
  2. Click **Playback/Record**. The Telephony/Web Client options screen appears.
3. Select **Say Date and Time** if you want to hear the date and time stamp before every message.

**Note:** All messages are tagged with a Date and Time stamp. Select **Say Date and Time** if you want to hear the date and time stamp before every message.

4. In the **Playback Device** drop-down list, select the device to use for message playback.

5. In the **Record Device** drop-down list, select the device to use for recording greetings and messages.

**Note:** If Phone is selected in either drop-down list, extra fields become available.
6. In the **Address Type** drop-down list, select the address type.

7. In the **Country** drop-down list, select the country that the phone is located in.

8. In the **Area/City Code** field, enter the area/city code for the phone number.

9. In the **Number** field, enter the phone number.

10. Click **Save**.
Maintaining Call Options

Call Options allows you the flexibility to assign transfer options and enable/disable call forwarding.

Specifying Transfer Options

By specifying the transfer options, the system will use the assigned active greeting and call functions to receive callers.

◆ **To transfer options:**

1. Click **User Settings**. The User Settings (General) screen appears.
2. Click **Transfer Options**. The Transfer Options screen appears.

3. From the **Active Greeting** drop down list, select the active greeting that you want the system to play when a caller dials your extension.

4. From the **Caller ID** drop down list, select the method that Web Client will use to notify you of a call.
Using the Web Client

5. From the Personal Operator drop-down list, select the personal operator extension that you want the call to be transferred to.

6. Select Call Screening if you want the system to instruct callers who want to be transferred to an extension to state their name at the tone.

Before the call is transferred, you will hear the caller’s name followed by the system prompt: “To accept the call press <1>, to reject the call press <#>, or to redirect the call press <2>.” If you reject the call, the caller hears a no-answer message and is given the choice of trying another extension, leaving a voice mail message, or dialing the operator’s extension. To redirect the call, press <2> and the destination extension number, then hang up to transfer the call.

7. Select Call Queuing if you want incoming calls to be placed in a queue when an extension is busy. Callers are informed of their position in the hold queue and given opportunities to either continue to hold or leave a voice message.

### Caller ID Function

- **None**: Turns off screen pops on Call Manager.
- **Ask**: Prompts a caller to input their phone number before Web Client transfers the call. The phone number is used in screen pops if you are using Call Manager.
- **Pop**: Provides a screen pop even if there is no caller ID information available.
- **Ask and Pop**: Prompts the caller to manually input their number so it can be used in the screen pop if no caller ID is available or it is not passed by the telco. This guarantees that a number appears for all incoming calls to you.

**Note**: In conjunction with the Caller ID option selected in this section, you must also enable the New Call Popup feature in the UM Client Manager settings in for screen pops to appear. Refer to the UM Client Manager and Desktop Applications chapter of this guide for more details.
Using the Web Client

Caution: Call Screening and Call Queuing are only available on telephone systems that provide a busy tone. Most telephone sets with multiple extension appearances do not produce a busy tone.

Note: Call Screening and Call Queuing are mutually exclusive. You must choose one or the other, but not both.

8. Click **Save**.

Enabling the Call Forwarding Feature

When call forwarding is enabled, all calls will be forwarded to the assigned number.

♦ **To enable call forwarding:**

1. Click **User Settings**. The User Settings (General) screen appears.

2. Click **Call Forwarding**. The Call Forwarding screen appears.

3. Select the **Call Forwarding Enable** checkbox if you want your calls to be forwarded to another extension.

4. From the **Call Forward to** drop-down list, select the extension where your calls will be forwarded to.

5. Click **Save**.
Maintaining Addresses

Adding a Phone Address

You can add a phone address at any time.

◆ To add a phone address:

1. Click **User Settings**. The User Settings (General) screen appears.
2. Click **Phone**. The Phone screen appears.

3. Click **Add**. The Add Address dialog appears.
Using the Web Client

4. From the **Address Type** drop down list, select an address type.

5. If you select External or Centrex, the **Country** and **Area/City Code** fields become active.

6. From the **Country** drop down list, select a country.

7. In the **Area/City Code** field, enter the area or city code.

8. In the **Number** field, change the extension.

9. Select **Set as Default** to specify the extension as the default, then click **OK**.
Using the Web Client

Editing a Phone Address

You can edit an existing phone address at any time.

**Note:** You cannot edit your extension from the General screen.

◆ **To edit the address type:**

1. Highlight a phone address and click **Edit**. The Web Page dialog appears.
2. Make the necessary changes, then click **OK**.

Deleting a Phone Address

You can delete an existing phone address at any time.

◆ **To delete an address type:**

1. Highlight the phone address that you want to delete and click **Remove**. A message appears, prompting you to confirm deletion.
2. Click **OK**.

Creating a Phone Addresses Schedule

You can create a Phone Addresses Schedule to specify which phone number the system should use at certain times. This is useful if you work from different phone numbers at different times or days.

◆ **To create a phone address schedule:**

1. Click **User Settings**. The User Settings (General) screen appears.
2. Click **Phone**. The Phone screen appears.
3. Click **Schedule**. The Phone Addresses Schedule dialog appears.
Using the Web Client

Note: Web Client automatically activates the schedule.

4. From the Default drop down list, select the default extension that will be used if the schedule expires.

5. From the From - year, month, and day drop down list, select the year, month, and day when you want the phone extension to start being used.

6. From the To - year, month, and day drop down list, select the year, month, and day when you want to stop using the phone extension.

Note: Select All Day if you want the voice menu to play all day.

7. Enter the From and To hours, in military format. For example, if your company wants the voice menu to play from 9:00 AM to 5:00 PM, set the hours as From 09:00 and To 17:00. If no time is entered, the system will assume all hours.

Note: A value of From 13:00 to blank indicates 1:00 PM to midnight.

The maximum value is 23:59 and the minimum value is 0:00.
Other than a Blank value, the From field cannot be greater than the To field.

8. Select the days of the week on which you want the extension to be called.

   **Note:** If you want this extension to be reached every day, select Every day.

9. From the **Phone Addresses** drop down list, select the phone addresses that will run.

10. Click **OK**.

**Specifying E-mail Addresses**

Specifying e-mail settings allows you a number of e-mail addresses where you can be reached when an unread message is received.

   **Note:** If you are a Unified user, do not specify your corporate e-mail address as it is already configured to receive messages.

   ◆ **To specify e-mail addresses and settings:**

   1. Click **User Settings**. The User Settings (General) screen appears.

   2. Click **E-mail**. The E-mail screen appears.
3. Select the **Send E-mail with New Messages** checkbox if you want to send defined e-mails with the message.

**Note:** The **Attach Voice File to E-mail** selection becomes active if you select Send E-mail with New Messages.

4. Select the **Attach Voice File to E-mail** checkbox if you want to attach a voice message to an e-mail.

**Note:** The destination e-mail server must be able to receive .WAV file attachments and the destination computer must have a .WAV file player.

5. Select the **Send E-mail with New Text Messages** checkbox if you want to send defined e-mails with the message.

6. Select the **Attach Text File to E-mail** checkbox if you want to attach a text file to the message.

7. Click **Add** to add an e-mail address. The e-mail address dialog appears.
8. In the E-mail Address field, enter the e-mail address.

9. Select Set as Default if you want to make this e-mail address the default address, then click OK.

10. Click Save.

Editing an E-mail Address

After specifying e-mail addresses, you can edit them at any time.

✦ To edit an e-mail setting:

1. Highlight the e-mail address you want to edit and click Edit. The e-mail address dialog appears.

2. Make the appropriate changes to the settings and click OK.

3. Click Save.

Removing an E-mail Address

You can delete e-mail addresses at any time.

✦ To remove an e-mail setting:

1. Highlight the e-mail address you want to delete and click Remove. The delete address dialog appears.

2. Click OK to confirm the deletion.

Configuring an E-mail Settings Schedule

An e-mail address schedule allows you to define when the system should send unread messages to certain individual e-mail addresses.

✦ To configure an e-mail settings schedule:

1. Click User Settings. The User Settings (General) screen appears.

2. Click E-mail. The E-mail screen appears.

3. Click Schedule. The e-mail schedule dialog appears.

4. Select the Schedule Enabled checkbox to enable the schedule.
5. In the **From Year/Month/Day** drop-down lists, select the year, month and day you want the schedule to begin.

6. In the **To Year/Month/Day** drop-down lists, select the year, month and day you want the schedule to end.

7. Click the checkbox that represents the day or days you want the schedule to be enabled or select the **Every day** checkbox to enable the schedule everyday.

8. In the **E-mail** drop-down list, select the e-mail address that is to be associated with the schedule.

9. Click **OK**.

**Specifying Fax Addresses**

You can specify and add Fax addresses.

- **To specify fax addresses:**
  1. Click **User Settings**. The User Settings (General) screen appears.
  2. Click **Fax**. The Fax screen appears.

  ![Fax Settings](image)

  3. Select the **Send E-mail with New Faxes** checkbox if you want to send defined e-mails with the message.
Using the Web Client

4. Select the **Attach Fax File to E-mail** checkbox if you want to attach a fax message to an e-mail.

5. In the Fax Number box, click **Add** to add a fax number. The Fax Number dialog appears.

6. In the **Internal/External** drop-down list, select whether the fax number is internal or external.

7. In the **Country** drop-down list, select the country in which the fax number resides.

8. In the **Area/City Code** field, enter the area/city code of the fax number.

9. In the **Number** field, enter the fax number.

10. Select the **Set as Default** checkbox if you want to make this e-mail address the default address and click **OK**.

11. Click **Save**.

12. To delete a fax number, highlight the number and click **Remove**.

13. To edit a fax number, highlight the number and click **Edit**.

**Configuring a Fax Number Schedule**

A Fax Number Schedule allows you to define when the system should send fax messages to certain fax extensions.

- **To configure a fax number schedule:**

1. Click **User Settings**. The User Settings (General) screen appears.

2. Click **Fax**. The Fax screen appears.

3. Click **Schedule**. The Fax Schedule dialog appears.

4. Select the **Schedule Enabled** checkbox to enable the schedule.

5. In the **From Year/Month/Day** drop-down lists, select the year, month and day you want the schedule to begin.

6. In the **To Year/Month/Day** drop-down lists, select the year, month and day you want the schedule to end.
7. Click the checkbox that represents the day or days you want the schedule to be enabled, or select the **Every day** checkbox to enable the schedule every day.

8. In the **Fax** drop-down list, select the fax extension that is to be associated with the schedule.

9. Click **OK**.

**VPIM Addresses**

The VPIM Addresses feature displays the user’s VPIM address. This address can only be changed by the administrator in the 6510 UM Administration console.

- **To view VPIM addresses:**
  1. Click **User Settings**. The User Settings (General) screen appears.
  2. Click **VPIM**. The VPIM screen appears, and displays all existing VPIM addresses.
**WAP Addresses**

Specifying a Wireless Application Protocol device address lets you define a WAP location to contact for message notification.

**To specify WAP addresses:**

1. Click **User Settings**. The User Settings (General) screen appears.
2. Click **WAP**. The WAP addresses screen appears.

3. In the **Country** drop-down list, select the country in which the WAP address is located.
4. In the **Area/City Code** field, enter the area/city code of the WAP address.
5. In the **Number** field, enter the WAP number.
6. Click **Save**.
Other Addresses

Specifying a SMS address lets you define a SMS location to contact for message notification.

◆ To specify other addresses:

1. Click **User Settings**. The User Settings (General) screen appears.
2. Click **Other**. The Other screen appears.

3. In the **SMS** field, enter the SMS address to send to.
4. In the **Reply To** field, enter an address that will appear in the message that the receiver will be instructed to reply to.
5. Click **Save**.

**Note:** Your SMS address is provided by your cell phone or pager service provider.
Maintaining a Distribution List

Creating a distribution list provides you with an easy way to send messages to a group of people. For example, if you frequently send voice mail to the sales team, you can create a distribution list called "Sales Team", which contains the names of all the members on the sales team.

You can use a distribution list to create either a voice mail or e-mail message.

Note: This option allows you to create and maintain up to 99 distribution lists.

Using the Toolbar Buttons

There are six buttons that allow you to perform various tasks within the Distribution List application.

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Create Distribution List</td>
<td>Creates a distribution list</td>
</tr>
<tr>
<td>-</td>
<td>Delete Distribution List</td>
<td>Deletes a distribution list</td>
</tr>
<tr>
<td></td>
<td>Save Distribution List</td>
<td>Saves the distribution list</td>
</tr>
<tr>
<td></td>
<td>Refresh Distribution List</td>
<td>Refreshes the distribution list if you make changes to it and do not click Save.</td>
</tr>
<tr>
<td></td>
<td>Add to list</td>
<td>Adds name/address to the list</td>
</tr>
<tr>
<td></td>
<td>Remove from list</td>
<td>Removes name/address from the list</td>
</tr>
</tbody>
</table>
Creating a Private Distribution List

You can create a private distribution list that includes a number of inboxes and e-mail addresses. When unread messages are received, the system will utilize the list and send the unread messages to the contacts on the private distribution list.

**Note:** Public distribution lists are created by the System Administrator.

◆ **To create a distribution list:**

1. Click **Distribution List**. The Distribution List screen appears.

2. Click **Create Distribution List**.

3. In the **List Number** field, enter the list number that you will reference from a phone.

   **Note:** For more information on accessing a distribution list from your phone, refer to the Telephone User Guide.

4. In the **List Name** field, enter a descriptive name for the distribution list.

5. In the **Mailboxes** field, enter the mailbox that you want to add to the distribution list.
Using the Web Client

Note: You can also highlight a mailbox, then click the Add to list arrow.

To remove a mailbox, highlight it, then click the Remove from list arrow.

6. The Remote Sites field displays all other networked locations via AMIS or VPIM. Highlight a user, then click the Add arrow. The Remote Sites dialog appears.

7. Enter the remote site address and click OK.

8. In the Email field, enter the e-mail address that you want to add to the distribution list, then click Save Distribution List.

Editing a Distribution List

After a distribution list is created, its properties can be edited.

To edit a distribution list:

1. Click the scroll buttons until you find the distribution list that you want to edit.

2. Make the necessary changes and click Save Distribution List.

Deleting a Distribution List

A distribution list can be deleted.

To delete a distribution list:

1. Click the Client scroll button to select a distribution list, then click Delete Distribution List. A message appears, prompting you to confirm deletion.

2. Click OK.
Maintaining Notifications

When you are away from your desk or out of the office, you often do not have any way of knowing if you have received an e-mail or voice message. Web Client has the ability to notify you if you have received e-mail or voice message. For example, if you have received a voice mail message, you can instruct Web Client to notify you by an e-mail message or call to your cell phone, home phone, or another e-mail account.

Using the Toolbar Buttons

There are six buttons that allow you to perform various tasks within the Notification application.

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="Image" alt="Save" /></td>
<td>Save</td>
<td>Save the notification.</td>
</tr>
<tr>
<td><img src="Image" alt="Refresh" /></td>
<td>Refresh</td>
<td>Refresh the display.</td>
</tr>
<tr>
<td><img src="Image" alt="Schedule" /></td>
<td>Schedule</td>
<td>Display Notification Schedule dialog.</td>
</tr>
<tr>
<td><img src="Image" alt="Add Item" /></td>
<td>Add Item</td>
<td>Add a notification schedule.</td>
</tr>
<tr>
<td><img src="Image" alt="Delete Item" /></td>
<td>Delete Item</td>
<td>Delete a notification schedule.</td>
</tr>
<tr>
<td><img src="Image" alt="Delete All" /></td>
<td>Delete All</td>
<td>Delete all notification schedules.</td>
</tr>
</tbody>
</table>

Creating a Notification Rule

Notification rules determine how Web Client will notify you when you receive an e-mail, voice mail, or fax. For example, if you want to be notified each time you receive a voice mail message, you can instruct the system to send you an e-mail. If you are using a cell phone, you can instruct the system to also contact you on the cell phone.

**Note:** You cannot have more than one notification rule running at a time.
To create a notification rule:

1. Click Notification. The Notification screen appears.

2. From the Notifying Mode drop-down list, select the mode to search the numbers for notifications.
Using the Web Client

<table>
<thead>
<tr>
<th>Mode</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restart from First</td>
<td>After going through all the numbers associated to a current schedule once, Web Client begins from the first number again if it has not notified you during a full cycle.</td>
</tr>
<tr>
<td>Restart after Last</td>
<td>Once going through a full cycle of the numbers with no successful notification, Web Client begins from the last address dialed and works its way backwards up the list.</td>
</tr>
</tbody>
</table>

3. In the **Account Code** field, enter your long distance access code if it is required to make a long distance call from your office.

4. In the **Notification Rules** box, Select the media type you want to set rules up for.

5. In the **Voice Mail Rules** box, select one or more voice mail rules. These rules determine when Web Client will notify you when you have received a message.

<table>
<thead>
<tr>
<th>Media Type</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Notify on all messages.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This is the default setting.</td>
</tr>
<tr>
<td>Certified</td>
<td>Notify only on messages marked certified.</td>
</tr>
<tr>
<td>Internal</td>
<td>Notify only on internal messages.</td>
</tr>
<tr>
<td>Urgent</td>
<td>Notify only on urgent messages.</td>
</tr>
<tr>
<td>Private</td>
<td>Notify only on private messages.</td>
</tr>
<tr>
<td>External</td>
<td>Notify only on external messages.</td>
</tr>
<tr>
<td>With Caller ID</td>
<td>Notify only on messages with caller ID.</td>
</tr>
</tbody>
</table>

**Note:** There are no rules for fax.

6. Click **Save**.
Creating a Notification Address

Web Client allows you to specify phone and e-mail addresses that will be used to contact you when you have a message. After you have specified the contact methods, you can assign a schedule to a particular notification address.

**Note:** If the Phone, Beeper, or E-mail option buttons are not active, contact your System Administrator.

There is no limit to the number of notification addresses that you can add.

Creating a Phone Notification Address

Web Client will contact you via the phone numbers that you specify each time you receive a voice message, e-mail, or fax.

◆ **To create a phone notification address:**

1. In the Notification Addresses box, click **Add**. The Address dialog appears.
2. Select **Phone**.

![Address dialog](Image)
Using the Web Client

3. From the **Country** drop down list, select a country

4. In the **Area/City Code** field, enter the phone number’s area code or city code.

5. In the **Number** field, enter the phone number.

6. In the **Call It** field, enter the number of times that Web Client is to call the phone number.

7. In the **Busy** field, enter the number of minutes that WebClient is to wait before retrying the number if it is busy.

8. In the **No Answer** field, enter the number of minutes that Web Client is to wait before retrying the number when there is a no answer.

9. Click **OK**. The phone number appears in the **Notification Addresses** field.

Creating a Beeper Notification Address

Web Client will contact you at the beeper numbers you create each time that you receive a voice message, e-mail, or fax.

◆ To create a beeper notification address:

1. In the **Notification Addresses** box, click **Add**. The Phone dialog appears.

2. Click **Beeper**. The Beeper dialog appears.
3. From the **Country** drop down list, select a country.

4. In the **Area/City Code** field, enter phone number’s area code or city code.

5. In the **Number** field, enter the phone number.

6. In the **Call It** field, enter the number of times that Web Client is to call the phone number.

7. In the **Between Calls** field, enter the duration of time to wait before retrying the number again. (In minutes).

8. In the **Wait** field, enter the duration of time to wait before sending (in seconds).

9. In the **Send** field, enter the personal message that will appear when you receive a notification. This feature allows you to personalize your beeper notification, so that you will be aware of where the notification is originating.

10. Click **OK** and then **Save**. The beeper number appears in the **Notification Addresses** field.
Using the Web Client

Creating an E-mail Notification Address

Web Client will contact you at the e-mail addresses that you create each time that you receive a voice message, e-mail, or fax.

To create an e-mail notification address:

1. In the Notification Addresses box, click Add. The Address dialog appears.
2. Click E-mail. The E-mail dialog appears.
3. In the E-mail field, enter the e-mail address, then click OK.

Removing a Notification Address

Individual notification addresses can be removed from a Notification List.

To remove a notification address:

1. Highlight the address that you want to delete, then click Remove. A message appears, prompting you to confirm the deletion.
2. Click OK.
Editing a Notification Address

The properties of individual notification addresses can be edited.

◆ To edit a notification address:

1. Highlight the notification address, then click Edit. Depending on the type of notification address you selected, the appropriate dialog appears.

2. Make the necessary changes, then click OK.

Creating a Notification Schedule

The Notification Schedule feature allows you to assign a schedule to a particular notification address. For example, you can create a schedule that instructs Web Client to call you on your cell phone Monday to Friday, between 9 am and 5 pm.

Note: You must save all of your notification addresses before creating a notification schedule.

◆ To create a notification schedule:

1. Click Schedule. The Notification Schedule dialog appears.
2. From the **Default** drop down list, select the notification address that Web Client will use to contact you if the schedule expires.

3. From the **From - year, month, and day** drop-down lists, select the year, month, and day that you want the schedule to begin.

4. From the **To - year, month, and day** drop-down lists, select the year, month, and day that you want the schedule to stop.

Note: **Select All Day** if you want the schedule to run all day.

5. Enter the **From** and **To** hours, in military format. For example, if your company wants the notification to play from 9:00 AM to 5:00 PM, set the hours as **From 09:00** and **To 17:00**. If no time is entered, the system will assume all hours.

Note: **A value of From 13:00 to blank indicates 1:00 PM to midnight.**

The maximum value is 23:59 and the minimum value is 0:00.

Other than a Blank value, the From field cannot be greater than the To field.

6. Select the days of the week that you want the schedule to run.

Note: **If you want the schedule to run every day, select Every day.**
Using the Web Client

**Caution:** If two notification schedules are created and the days that they are designated to run overlap, the system will choose to use the default address. If the default address is not one of the addresses specified in the schedules, the system will randomly select an address.

7. From the **Notification Addresses** drop down list, select the notification addresses that will run.

8. Click **OK**.

Maintaining Wakeup Calls

You can use Web Client to act as an alarm clock to wake you up at a specified time.

**Using the Toolbar Buttons**

There are three buttons that allow you to perform various tasks within the Wakeup Call application.

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>ลบ</td>
<td>Clear</td>
<td>Clears the fields of information.</td>
</tr>
<tr>
<td>📜</td>
<td>Update</td>
<td>Updates the wakeup call.</td>
</tr>
<tr>
<td>🔄</td>
<td>Refresh</td>
<td>Refreshes the display.</td>
</tr>
</tbody>
</table>
Creating a Wakeup Call

- **To create a wakeup call:**

1. Click **Wakeup Call**. The Wakeup Call screen appears.
2. From the **Country** drop down list, select a country.
3. In the **Area/City Code** field, enter either an area code or a city code.
4. In the **Number** field, enter the seven-digit phone number.
5. From the **Date (month)** drop down list, select the month.
6. From the **Date (day)** drop down list, select the day.
7. In the **Time (hour)** and **Time (min)** fields, enter the time when you want Web Client to issue the wakeup call, then click **Update**.
**Using the Web Client**

---

**Cancelling a Wakeup Call**

You can cancel a wake up if you do not want to woken at the specified time.

- **To cancel a wakeup call:**
  1. Select a wakeup call.
  2. Click **Clear**. A message appears, prompting you to confirm deletion.
  3. Click **OK**. Web Client removes the wakeup call information from the display.

**Maintaining Greetings**

The Web Client comes equipped with 10 basic status messages that can be used to inform callers of your status (such as when you are on vacation, for example). You can also record up to 99 optional greetings.

**Note 1:** Before you can record a greeting, you must have the Grant Permissions and Java Plug-In software installed on your PC. For more information, refer to the *Client Application Installation Guide* or contact your System Administrator.

**Note 2:** You must have a microphone attached to your PC to record a greeting. You can also record the greetings from your telephone. Refer to the *Telephone User Guide* for more information.
Using the Web Client

Using the Toolbar Buttons

There are five buttons that allow you to perform various tasks within the Greetings application.

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Delete</td>
<td>Deletes a greeting</td>
</tr>
<tr>
<td></td>
<td>Record</td>
<td>Records a greeting.</td>
</tr>
<tr>
<td></td>
<td>Play</td>
<td>Plays a greeting.</td>
</tr>
<tr>
<td></td>
<td>Refresh</td>
<td>Refreshes the screen.</td>
</tr>
<tr>
<td></td>
<td>Play</td>
<td>This icon appears beside a greeting if it a message has been recorded for it.</td>
</tr>
</tbody>
</table>

Playing a Greeting

You can listen to your current or recorded greeting by using the Windows Sound Player.

- **To play a status greeting:**
  1. Click the **Play** icon beside the greeting that you want to play. The Windows Sound Player becomes active and plays the message.

  ![Microsoft Internet Explorer](Image)

  2. To play another greeting, close the Windows Sound Player, then repeat step 1.
Recording a Greeting

Web Client allows you to create a greeting for each of the nine presence statuses.

**Note:** The status greeting for the Name status is recorded when the System Administrator sets you up on the 6510 UM system. However, you can change the greeting.

- **To create a status greeting:**
  1. Click **Greetings**. The Greetings screen appears.

![Greeting Screen](image)

  2. From the **Language** drop down list, select the language that you want to record the message in.

  **Note:** The number of available languages depends on the languages that were specified when the 6510 UM was installed. For more information, contact your System Administrator.

  3. Select the greeting that you want to record and click **Record**. The Windows Sound Recorder becomes active.
4. In the Windows Sound Recorder, click Record and begin speaking. The record button changes to the pause button.

5. When you have recorded your message, click Stop.
6. Click Play to listen to your recorded message.
7. If you are satisfied with the message, click Save.

   Web Client places an Play icon beside the new greeting.

8. To play the greeting, select the radio button designated to the greeting type and click Play.
Activating a Greeting

To activate a recorded greeting, select the greeting and it will be activated.

Deleting a Greeting

Web Client allows you to delete any greeting that you have recorded.

🔹 To delete a greeting:

1. Select the greeting and click **Delete**. A message appears, prompting you to confirm deletion.

   **Note:** If you want to delete an Optional greeting, enter its number in the Optional field.

2. Click **OK**. Web Client removes the Play icon from the greeting.
Using the Collaborate Feature

Collaboration is a facility that is provided to link you with your desired Collaboration/Meeting services. Once you define the collaboration service in the User Settings, simply click the **Collaborate** button, a new window will open and connect you to the defined Collaboration service.

**Note: WebEx is defined by default.**
CHAPTER 5  Using the WAP Client

In This Chapter...

Overview on page 178
Requirements on page 178
Logging In Via WAP Client on page 180
WAP Client Functions on page 182
Setting a Callback Number on page 183
Setting a Fax Number on page 187
Setting an Active Extension on page 191
Setting the Status on page 196
Checking Messages on page 198
Replying To Messages on page 200
Creating a New Message on page 205
Forwarding Messages on page 208
Maintaining Folders on page 212
Overview

The Wireless Application Protocol (WAP) is the world standard for the presentation and delivery of wireless information and telephony services on mobile phones and other wireless terminals. WAP introduces the concept of the Internet as a wireless service platform. By addressing the constraints of a wireless environment, and adapt existing Internet technology to meet these constraints, WAP has succeeded as a standard that scales across a wide range of wireless devices and networks.

The 6510 UM system is WAP-capable, allowing users to access their messages via a WAP-enabled mobile device. Using the WAP client, users can receive text, voice, and fax messages, create new messages, set an active extension, and toggle user status.

Requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Component Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mobile Device</td>
<td>WAP-enabled</td>
</tr>
<tr>
<td>Fully Qualified Domain Name</td>
<td>FQDN dedicated to WAP access</td>
</tr>
<tr>
<td>UMSentinel</td>
<td>Must be registered for WAP</td>
</tr>
<tr>
<td>Desktop Capabilities</td>
<td>Each user using WAP must be licensed for Unified Messaging</td>
</tr>
</tbody>
</table>
Using the WAP Client

Ensure that your UMSentinel License is registered for WAP access, by checking to see if the WAP checkbox is enabled in the UMSentinel Upgrade Utility.

Ensure that each intended user of WAP services is registered as a Unified Messaging user, by checking in the Mailbox>Advanced tab for each user.
Logging In Via WAP Client

On your WAP-enabled mobile device, you can use the browser to connect to your company mailbox.

◆ To log in:

1. On your mobile device browser, enter the FQDN (WAP supported). For example, wap.(companyname).com. The Company No. screen appears.

2. Enter your Company number, and then select OK. The Mailbox No. screen appears.

3. Enter your mailbox number (usually your phone extension), and then select OK. The Password screen appears.
Using the WAP Client

4. Enter your personal password, and then select OK. The Language screen appears.

5. Select the language that you want to use, and then select OK. The Go screen appears.

7. You have successfully logged into your mailbox using the WAP Client.

**WAP Client Functions**

When using WAP Client, you can:

- Set Callback Numbers
- Set Fax Numbers
- Set Active Extensions
- Set Status
- Create New Messages
- Check Messages
- Delete/Forward Messages
- Manager Folders
Setting a Callback Number

Setting a callback number allows you to listen to voice messages that are received on your company’s server. Once you assign a callback number and a voice message is received, the system can call the assigned callback number and play the voice message to the recipient.

◆ To set a callback number:

1. In the Message List, select **Menu**. The Main Menu screen appears.

   ```
   1 New message
   2 Delete read
   3 Folders>
   4>Callback numbers>
   5 Fax numbers>
   6 Active extensions>
   OK
   ```

2. Select **Callback Numbers**, and then select **OK**. The list of callback numbers appears. (In this example, there are no numbers set, therefore, none are listed).

   ```
   Number with '>' mark is default
   ▶>[> ]
   ```

3. Select **Menu**. The Create screen appears.
4. Select **Create**, and then select **OK**. The Country Code screen appears.

5. Enter the country code of the callback number you want to set, and then select **OK**. (This is only needed if the callback number is in a different country). The Area Code screen appears.

6. Enter the area code of the callback number, and then select **OK**. The Number screen appears.
Using the WAP Client

7. Enter the number for the callback number, and then select **OK**. The Create screen appears.

8. Select **Create**, and then select **Link**. The Callback Number list appears, displaying the new callback number.

9. You have successfully designated a callback number for message playback.
Deleting a Callback Number

Callback Numbers within your callback number list can be removed at any time.

- **To delete a callback number:**

  1. In the Callback Number list screen, select the number that you want to delete, and then select **Link**. The Delete screen appears.

     ![Delete Screen](image)

     Number (416) 888-0728
     (this number is default)
     [Make default ]
     [Delete ]
     [Cancel ]

     Link

  2. Select **Delete**, and then select **Link**. The Callback Number list appears, with the deleted callback number removed.

     ![Callback Number List](image)

     Number with '>' mark is default
     [>] [ ]

     Link  Menu
Using the WAP Client

Setting a Fax Number

When you receive a facsimile in your mailbox, you can designate a fax number from your mobile device, so that the fax can be printed and viewed.

- **To set a fax number:**

  1. In the Main Menu screen, select **Fax Numbers**, and then select **OK**. The Create screen appears.

  2. Select **Create**, and then select **Link**. The Country Code screen appears.
Using the WAP Client

3. If the fax number that you want to assign requires a country code, enter the country code, and then select **OK**. If a country code is not required, leave this field empty and select **OK**. The Area Code screen appears.

```
Area code (opt):
416|
```

4. Enter the area code of the fax number, and then select **OK**. The Number screen appears.

```
Number:
2225928|
```

5. Enter the fax number, and then select **OK**. The Create screen appears.

```
[Create ]
[Cancel ]
```

6. Select **Create**, and then select **Link**. The Fax Number list appears, displaying the assigned fax number as its default.
7. You have successfully assigned a fax number that can be used to send and print faxes to.

Deleting a Fax Number

You can delete assigned fax numbers at any time.

◆ To delete a fax number:

1. New message
2. Delete read
3. Folders>
4. Callback numbers>
5. Fax numbers>
6. Active extensions>

OK
Using the WAP Client

1. In the Main Menu, select **Fax Numbers**, and then select **OK**. The Fax Number list screen appears.

2. Select the fax number that you want to delete, and then select **Link**. The Delete screen appears.

3. Select **Delete**, and then select **Link**. The Fax Number list appears, with the deleted fax number removed.
Setting an Active Extension

You can designate an active extension to ensure that you receive all of your calls while away from the office. Setting an active extension forwards all calls received at your office extension to any mobile device.

To set an active extension:

1. In the Main Menu screen, select Active Extensions, and then select OK. The Extension list appears.

2. Select your office extension, and then select Link. The Create screen appears.
Using the WAP Client

3. Select Create, and then select OK. The Type screen appears.

4. Select the type of extension that you will be assigning, and then select OK. The Next screen appears.

   Note: If you are assigning another internal extension within your company, select Internal. If you are assigning an external number such as a home or mobile device number, select External. If you are Centrex extension, select Centrex.

5. Select Next, and then select Link. The Country Code screen appears.
6. If applicable, enter the country code of the active extension that you want to assign, and then select **OK.** The Area Code screen appears.

7. Enter the area code of the active extension that you want to assign, and then select **OK.** The Number screen appears.

8. Enter the active extension number, and then select **OK.** The Create screen appears.
9. Select **Create**, and then select **Link**. The Active Extension list appears, displaying the assigned active extension number as the default extension.

10. You have successfully assigned an active extension.
Deleting an Active Extension

Active extensions can be deleted from the Active Extension list at any time.

- **To delete an active extension:**

1. In the Main Menu screen, select **Active Extensions**, and then select **OK**. The Active Extension list appears.

2. Select the active extension that you want to delete, and then select **Link**. The Delete screen appears.
Using the WAP Client

3. Select **Delete**, and then select **Link**. The Active Extension list appears, with the deleted active extension removed.

Setting the Status

You can use your mobile device to toggle your user status.

The Status types to select from include:

<table>
<thead>
<tr>
<th>Status Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>In Office</td>
<td>Indicates that you are in office and available</td>
</tr>
<tr>
<td>Lunch Time</td>
<td>Indicates that you are on lunch</td>
</tr>
<tr>
<td>Busy</td>
<td>Indicates that you are currently busy and unavailable</td>
</tr>
<tr>
<td>Gone Home</td>
<td>Indicates that you have left the office for the day</td>
</tr>
<tr>
<td>DND</td>
<td>Indicates that you are in Do Not Disturb mode</td>
</tr>
<tr>
<td>Meeting</td>
<td>Indicates that you are currently in a meeting</td>
</tr>
<tr>
<td>Out of Town</td>
<td>Indicates that you are away from the office attending to business matters</td>
</tr>
<tr>
<td>Vacation</td>
<td>Indicates that you are on holiday</td>
</tr>
<tr>
<td>No Answer</td>
<td>The default setting, indicates that you are not answering your calls</td>
</tr>
</tbody>
</table>
To set your status:

1. In the Main Menu, select **Status**, and then select **OK**. The **Now You Are** screen appears.

2. Select the status that you want to set, and then select **OK**. The **Set** screen appears.

3. Select **Set**, and then select **Link**. Your status is now set.
Checking Messages

Using the WAP client on your mobile device, you can check messages that are received in your company mailbox.

Codes are used to identify the message type that is received (voice message, fax, e-mail, unread, read, urgent, and attachment).

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>V</td>
<td>Indicates a voice message</td>
</tr>
<tr>
<td>F</td>
<td>Indicates a fax message</td>
</tr>
<tr>
<td>E</td>
<td>Indicates an e-mail message</td>
</tr>
<tr>
<td>U</td>
<td>Indicates an unread message</td>
</tr>
<tr>
<td>R</td>
<td>Indicates a read message</td>
</tr>
<tr>
<td>!</td>
<td>Indicates an urgent message</td>
</tr>
<tr>
<td>&amp;</td>
<td>Indicates a message with an attachment</td>
</tr>
</tbody>
</table>

◆ To check messages:

```
[04/16/03 11:42
Vincent Luk EU&]
[04/16/03 11:39
Vincent Luk FR]
[04/11/03 15:48
<unknown> VR!]
```

Link Menu
Using the WAP Client

1. In the Message List, select the message that you want to check, and then select **Link**. The Message Information screen appears.

   - If the message is an e-mail message, use the directional keys on your device to scroll down and read the message.
   - If the message is a fax message, proceed to step 2.
   - If the message is a voice message, proceed to step 3.

2. If the message is a fax, select **Menu**. The Menu screen appears.

   - 1 Reply
   - 2 Request playback
   - 3 Request fax
   - 4 Forward
   - 5 Delete

3. Select **Request Fax**, and then click **OK**. The fax message is sent to the assigned Fax Number.

   **Note:** A Fax Number must be assigned in order for the Request Fax function to operate. The default Fax Number will be used. See Setting a Fax Number on page 187 for more details.

4. If the message is a voice message, select **Menu**. The Menu screen appears.
5. Select **Request Playback**. The Voice Playback Requested screen appears, confirming that the system will now call the assigned Callback Number to play the voice message.

**Note:** A Callback Number must be assigned in order for the Request Playback function to operate. The default Callback Number will be used. See Setting a Callback Number on page 183 for more details.

**Replying To Messages**

After checking your messages, you can reply to them via your mobile device, either in text or voice format.

- **To create a text reply:**

```
From: (Private)
Subj: Certified Reply
Message
Type: Fax
```
1. While in the message that you want to reply to, select Menu. The Menu screen appears.

   1. Reply
   2. Request playback
   3. Request fax
   4. Delete

   OK

2. Select Reply, and then select OK. The Reply To screen appears.

   Reply to:
   Subj:
   Re: Certified Reply Message

   OK alpha

3. Change the Subject line (if applicable), and then select OK. The Importance screen appears.

   Importance:
   1. Normal
   2. Urgent

   OK

4. Select Normal or Urgent importance, and then select OK. The Private screen appears.
Using the WAP Client

5. Select No or Yes for private status, and then select OK. The Text screen appears.

6. Enter the reply message. When finished, select OK. The Reply screen appears.

7. Select Reply, and then select Link. The reply message is sent to the recipient.
To create a voice reply:

Note: In order to create a voice reply, you must first use the Callback Number feature to listen to the message on your mobile device.

1. In the message that you want to reply to, select **Menu**. The Menu screen appears.

   ![Menu Screen]

   1. Reply
   2. Request playback
   3. Request fax
   4. Forward
   5. Delete

   ![Confirmation Screen]

   OK

2. Select **Request Playback**, and then select **OK**. The confirmation screen appears, notifying you that the defined callback number will be contacted.

   ![Playback Screen]

   Voice playback requested (phone number (416)8880728), please wait for call
   
   ![Back]

Link

Once your callback number is contacted (mobile device), answering it allows you to listen to the message. When you finish listening to the message, the system provides you with the following options:
Using the WAP Client

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Skip to next message</td>
</tr>
<tr>
<td>2</td>
<td>Move to deleted folder</td>
</tr>
<tr>
<td>3</td>
<td>Review</td>
</tr>
<tr>
<td>4</td>
<td>Forward</td>
</tr>
<tr>
<td>5</td>
<td>Reply</td>
</tr>
<tr>
<td>6</td>
<td>Time/Date</td>
</tr>
</tbody>
</table>

Note: These options are set by default. Please refer to your Telephone User Guide for more details. The settings and functions of your company may be customized to be different.

3. On your mobile device, press [5] to reply to the message. The system prompts you to begin recording your reply at the sound of the tone.

4. At the tone, begin recording your reply message.

5. When complete, press [#]. The system confirms that your message has been sent.
Creating a New Message

Using your WAP-enabled mobile device, you can create new e-mail messages to any recipients with a valid e-mail address.

◆ To create a new message:

1. In the Main Menu, select New Message, and then select OK. The To screen appears.

2. Enter the e-mail address of the recipient that you are sending the message to, and then select OK. The Subject screen appears.
Using the WAP Client

3. Enter the subject for the message you are creating, and then select **OK**. The Importance screen appears.

4. Select the importance of the message, Normal or Urgent, and then select **OK**. The Private screen appears.

5. Select the private status of the message, and then select **OK**. The Body screen appears.
6. Enter the message that you want to send, and then select **OK**. The Send screen appears.

7. Select **Send**, and then select **Link**. The created message is sent to the identified recipient.
Forwarding Messages

Using your mobile device, you can forward any received messages to any recipient with a valid e-mail address.

◆ To forward a message:

1. In the message that you want to forward, select **Menu**. The Menu screen appears.

2. Select **Forward**, and then select **OK**. The Original Message screen appears.
Using the WAP Client

3. In the Forward to: field, enter the e-mail address of the recipient that you want to forward the message to, and then select OK. The Subject screen appears.

4. Enter a new subject line (if applicable), and then select OK. The Importance screen appears.

5. Select the level of importance for the message, and then select OK. The Private screen appears.

6. Select the private status of the message, and then select OK. The Your Comments screen appears.
7. Enter a message to accompany the forwarded message, and then select **OK**. The Forward screen appears.

8. Select **Forward**, and then select **Link**. The message is forwarded, along with your comments.
Deleting Messages

Using your mobile device, you can delete messages in your inbox at any time.

To delete a message:

1. In the message that you want to delete, select **Menu**. The Menu screen appears.

2. Select **Delete**, and then select **OK**. The message is deleted and removed from the message list.
Maintaining Folders

You can view, create, and delete folders within your mailbox using your WAP-enabled mobile device.

◆ To maintain folders:

1. In the Main Menu, select **Folders**, and then select **OK**. The Path screen appears.

2. Select **Link**. The Folders List appears.
Using the WAP Client

- To view messages within a folder, select a folder, and then select Link. The message list for the selected folder appears.

- To Create a folder, select Create Folder. The Create Folder screen appears.

3. Enter a name for the folder that you are creating, and then select OK. The Create screen appears.

4. Select Create, and then select Link. The Folders List appears, including the new folder that you have created.